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Important Note!
As part of Sprint's Trial Program, you have received an early beta version of the 
AirCard• 595 PC Card. Therefore, as a beta user, you may experience some early 
issues with the PC Card, which we strongly encourage you to report.

Also, some of the features mentioned in this User's Guide will not be available 
until the final commercial version of the PC Card and Sprint's 1xEV-DO Rev A 
network are available.

For more information, please review the terms and conditions agreement for 
the trial program.
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Welcome to Sprint

We are committed to bringing you the best wireless technology available, and we 
built our network right from the start, so no matte r where you are on the 
Nationwide Sprint PCS! Network, all your services will work the same.

When it comes to mobile connectivity, the Sprint Mobile Broadband Card offers 
more freedom than ever before. No wires, no cables, just access to your data when 
you need it. The power of the Internet and company data is truly at your 
fingertips.

This guide will familiarize you with our technology and with your new 

Sprint Mobile Broadband Card and Sprint PCS Connection ManagerSM software 
through simple, easy-to-follow instructions.

Welcome and thank you for choosing Sprint.
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Introduction to This User's Guide

This User's Guide introduces you to Sprint PCS Service and all the features of your 
new wireless Sprint Mobile Broadband Card. It's divided into six sections:

l Section 1:  Basics of Your Sprint Mobile Broadband Card

l Section 2:  Installing the Sprint Mobile Broadband Card

l Section 3:  Using the Sprint Mobile Broadband Card

l Section 4:  Technical Specifications and Regulatory Information

l Section 5:  Safety Information and Terms & Conditions

l Section 6:  Glossary and Index

Throughout the guide, you'll find tips that highlig ht special shortcuts and timely 
reminders to help you make the most of your wireless PC Card modem and 
service.

The Table of Contents and Index will help you locate specific information quickly. 
The Sprint PCS Connection Manager software includes extensive online help to 
guide you through the steps to use each feature.

You'll get the most out of your new Sprint Mobile Broadband Card if you read each 
section of this document. However, if you'd like to get right to a specific feature, 
simply go to that page. Follow the instructions in that section and you'll be ready 
to use your card in no time.

Tip: You can view this guide online or print it to keep on hand. If you're viewing it 
online, simply click a topic in the Table of Contents, or a page number in the 
Index, or any page reference or section reference. The PDF automatically displays 
the appropriate page.
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Basics of Your 
Sprint Mobile Broadband Card
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Sect ion 1A

Introducing the Sprint Mobile Broadband Card

In This Section

l Your Sprint Mobile Broadband Card

l CDMA Networks

l Package Contents

l About This Guide

This section introduces the basic features and functions of your Sprint Mobile 
Broadband Card, what is included with your card, and how to use this guide 
to get you started.
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Your Sprint Mobile Broadband Card

The Sierra Wireless AirCard! 595 PC Card is a dual-band wireless PC Card for 
cellular and PCS networks. It enhances the functionality of your mobile computing 
devices by adding wireless data.

This card allows you to do the following (subject to feature availability), without 
using a landline phone or network:

v Connect to the Internet, VPN, and corporate networks

v Send and receive email

Your Sprint Mobile Broadband Card fits into a Type II PC Card slot (available on 
most notebook PCs).

CDMA Networks

The Sprint Mobile Broadband Card operates over a type of wireless network called 
CDMA (Code Division Multiple Access).

To use the Sprint Mobile Broadband Card, you need an account that gives you 
access to the CDMA network. Some features described in this manual may not be 
available with your account. For details of the services and accounts available, 
contact Sprint (page 27).

There are CDMA networks that operate in the frequency bands supported by 
the Sprint Mobile Broadband Card throughout North America and parts of Latin 
America, Asia, and New Zealand. However, each service provider operates a 
network that covers a limited geographical area within the overall CDMA coverage 
area.

The fee for service is usually higher when you are roaming (connecting to a 
network other than Sprint).

Sprint has ªroamingº agreements with other service providers, so that you can get 
service outside of the coverage area of the Sprint PCS Vision! network. For 
example, assuming you live in Seattle and travel frequently to Vancouver, you can 
obtain an account with a service provider in Seattle that has a roaming agreement 
with a service provider in Vancouver. You would then have local service in Seattle, 
and roaming service in Vancouver. (There may be additional charges for roaming 
service.)
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CDMA technology provides a variety of connectivity features, depending on your 
Sprint account (actual speed depends on the network conditions):

v 1xEV-DO Rev. A (Sprint Power VisionSM) supports Internet connections with data 
rates up to 3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink to the 
network). Average data rates are roughly 600-1300 kbps (downlink from the 
network) and 300-400 kbps (uplink to the network).

v 1xEV-DO Rev. 0 (Sprint Power Vision) supports Internet connections with data 
rates up to 2.4 Mbps (downlink from the network) and 153 kbps (uplink to the 
network). Average data rates are roughly 400-700 kbps (downlink from the 
network) and 40-80 kbps (uplink to the network).

v 1X (Sprint PCS Vision) supports Internet connections with data rates up to 
153 kbps.

You can set Sprint PCS Connection Manager to automatically establish a packet 
data connection (Sprint Power Vision or Sprint PCS Vision) when it starts. If the 
packet data connection is lost, the connection is restarted automatically. This 
provides an ªalways-onº network connection (as far as permitted by network 
coverage). Once the connection is established, you can open your browser and 
connect to any Web site that is accessible through the Internet, or access other 
Internet services (such as email).

The connection is ªactiveº when data transmission is occurring. If data 
transmission stops for a period of time (determined by the network), the 
connection becomes ªdormant.º (See page 35.)

Tip: More information about CDMA networks is available on the CDMA Development 
Group Web site, www.cdg.org.

Tip: For pointers on optimizing your settings, see ªHow can I optimize my settings to 
achieve the fastest speeds and conserve data when accessing my corporate 
network?º on page 77.
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Package Contents

Your Sprint Mobile Broadband Card package contains the following components:

v Sprint Mobile Broadband Card by Sierra Wireless (Model AirCard 595)

v Getting Started guide

v Installation CD containing the Sprint PCS Connection Manager software, 
warranty information, and this document

About This Guide

This user©s guide is designed to provide you with all the information you need to 
install and use your Sprint Mobile Broadband Card by Sierra Wireless 
(AirCard 595).

v Section 1 (which you are reading) gives you an overview of the Sprint Mobile 
Broadband Card (AirCard 595).

v Section 2 provides step-by-step instructions for installing the Sprint Mobile 
Broadband Card and Sprint PCS Connection Manager software (page 13).

v Section 3 provides step-by-step instructions on using the card (page 29).

v Section 4 provides electrical, radio frequency, and other parameters of the 
Sprint Mobile Broadband Card for those who require technical information, as 
well as regulatory information (page 85).

v Section 5 provides important safety and liability informatio n and the Terms and 
Conditions of use for the Sprint Mobile Broadband Card (page 101).

v Section 6 include a glossary (page 117) and index (page 121).

Note: The comprehensive Getting Started guide that comes with the 
Sprint Mobile Broadband Card should be sufficient for most installations.
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Sect ion 1B

Getting Started With Your Sprint Mobile 
Broadband Card

In This Section

l Getting Started

l System Requirements

l The Sprint Mobile Broadband Card Software

l Care and Maintenance

This section describes the basics of getting started with your Sprint Mobile 
Broadband Card, and how to look after your Sprint Mobile Broadband Card.
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Getting Started

Before you begin using your AirCard 595 Sprint Mobile Broadband Card, you must:

1. Check that your notebook has the system requirements listed below (ªSystem 
Requirementsº).

2. Install the Sprint PCS Connection Manager software, located on the 
installation CD, onto your Notebook PC. See page 16.

3. After you restart your computer, start Sprint PCS Connection Manager.

4. Insert the Sprint Mobile Broadband Card; this installs the drivers for the card. 
See page 20.

5. Activate your Sprint PCS account and configure the SprintMobile Broadband 
Card to use your account (unless the card has been preactivated). See page 24.

System Requirements

The AirCard 595 Sprint Mobile Broadband Card is supported on:

v Windows XP (Home and Professional versions).

v Windows 2000 with Service Pack 1 or later (Service Pack 4 is recommended), 
with high encryption support. (See ªHigh Encryption Requirementsº on page 9.)

CAUTION: Do not insert the Sprint Mobile Broadband Card into the PC Card slot 
until you have installed and run Sprint PCS Connection Manager 
software, and the software displays ªNo device.º
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To install and run the Sprint Mobile Broadband Card and accompanying 
Sprint PCS Connection Manager software, you will need the minimum system 
resources shown in the following table.

High Encryption Requirements

Depending on your configuration, an IOTA session may automatically start as part 
of the installation/activation process. IOTA requires high-security 128-bit 
encryption to establish a secure Internet connection to the CDMA network.

If you are running Windows XP, your computer should already include high-
security 128-bit encryption.

If you are running Windows2000 with Internet Explorer
1. Ensure you have installed the Windows 2000 High Encryption Pack: in Internet 

Explorer, select Help > About Internet Explorer.

If you see ªCipher Strength: 128-bit,º then the High Encryption Pack is 
installed. Proceed to step 2.

If the High Encryption Pack is not installed, download and install it 
(www.microsoft.com/windows2000/downloads/recommended /encryption ).

2. If your version of Internet Explorer is earlier than 5.5, download and install the 
latest version (www.microsoft.com/windows/ie/downloads ).

Card slots One Type II PCMCIA (PC Card) slot

Disk drive CD-ROM

Memory 32 MB

Disk space 32 MB
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If you are running Windows 2000 with Netscape Communicator

Ensure your version of Netscape Communicator is 4.7 or higher.

To verify that your version supports 128-bit encryption:

1. In Navigator, select Help > About Navigator. 

± or ±

In Netscape Communicator, select Help > About Communicator.

2. See the section ªContains encryption software from RSA Data Security, Inc.º 

If the next paragraph states ªThis version supports U.S. security,º you have 
128-bit security.

If the paragraph states that you have International security, you have 40-bit 
security. Download a version that supports 128-bit security.

The Sprint Mobile Broadband Card Software

The Sprint Mobile Broadband Card comes with the following software:

v Sprint PCS Connection Manager, which allows you to manage the card's actions 
and monitor your connections

v The driver software that forms the interface between the Sprint Mobile 
Broadband Card and your Windows operating system

Before you insert the Sprint Mobile Broadband Card for the first time, you must 
install and then run the Sprint PCS Connection Manager software. The driver 
software is installed the first time you insert the card into your computer.

Detailed instructions are provided beginning on page 16.
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Care and Maintenance

As with any electronic device, the Sprint Mobile Broadband Card must be handled 
with care to ensure reliable operation. Follow these guidelines in using and storing 
the card:

v Do not apply adhesive labels to the card, as they may cause the card to become 
jammed inside the card slot.

v The card should fit easily into your PC slot. Forcing the card into a slot may 
damage connector pins.

v Protect the card from liquids, dust, and excessive heat.

v When not installed in your computer, store the card in a safe place.

v When storing or transporting your computer, remove the Sprint Mobile 
Broadband Card.

v When removing your Sprint Mobile Broadband Card, always grip it by the sides 
of the card rather than the top. Never insert or remove the card while holding 
the antenna, as this action may damage the card (see diagrams on page 21).

v Do not use the Sprint Mobile Broadband Card with a handheld computer; it is 

designed only for notebook computers running Windows!  XP or 2000.

v If driving or operating a vehicle, do not handle or operate the SprintMobile 
Broadband Card. Doing so may distract you from properly operating the vehicle. 
In some states and provinces, operating communication devices while in 
control of a vehicle is a criminal offense.
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Broadband Card
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Sect ion 2A

Installing the Software

In This Section

l Getting Started

This section explains how to install your Sprint PCS Connection Manager 
software.

The process may vary, depending on the operating system that you are running.
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Getting Started

Before you can use your Sprint Mobile Broadband Card, you must first install the 
card's software and configure the card for your computer. The installation process 
consists of:

v Software installation  - Installing the Sprint PCS Connection Manager software 
on your computer (described in this section).

v Card insertion and driver installation - Starting the Sprint PCS Connection 
Manager software and inserting the Sprint Mobile Broadband Card, which 
automatically installs the drivers on your computer.

v Card activation and provisioning - Activating your Sprint PCS account and 
configuring your Sprint Mobile Broadband Card to use your account. (See 
ªSetting Up Serviceº on page 23.)

1. If the installation CD is not already in your CD-ROM drive, insert it.

The CD should autostart.

If the CD does not autostart, select Start > Run and enter d:\SCMInstaller.exe, 
where d is the drive letter of your CD-ROM drive.

NOTE: For comprehensive instructions on installing the Sprint PCS Connection 
Manager software and activating the card, see the Getting Started guide.

CAUTION: Do not insert the  Sprint Mobile Broadband Card into your PC Card slot 
before installing the software.

NOTE: Windows 2000 users: You must log  in with administrative privileges to 
install the software and drivers.
Windows XP users:  You may need to log  in with administrative privileges, 
depending on your Windows configuration.
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2. Use the Next and Back buttons to navigate through the wizard, noting the 
following:

n You must select I accept the terms in the license agreement to indicate your 
acceptance of the terms of the license agreement to proceed with the 
installation.

n Use the default settings for the Destination Folder unless you have special 
requirements and an advanced understanding of PC configuration. (The 
Destination Folder dictates where the software is installed.)

n To install the optimization software (optional; this  software can increase 
your perceived system speed), in the Installation Options window, select 
the check box for the Data Optimization Client.

3. At the end of the installation, you will be prompted to restart your computer. 
Ensure that you save your work in other applications, if applicable.

4. When the ªInstallation Complete"º window is displayed, click Restart to restart 
Windows.

5. When Windows has restarted, run Sprint PCS Connection Manager.

(Double-click the program's icon [ ] on your desktop.)

6. Once Sprint PCS Connection Manager displays ªNo device,º insert the card into 
the PC Card slot, Sprint label facing up. (See page 20.)

Windows detects the card and installs the drivers for it. This may take a few 
minutes. Once completed, Sprint PCS Connection Manager should display 
ªDisconnected.º

Proceed to configure the Sprint Mobile Broadband Card to use your account (if it 
was not preactivated); see ªActivating and Using Sprint PCS Serviceº on page 24. If 
your card is preactivated, then you are ready to connect to the network; to learn 
about using the software, see ªYour Sprint Mobile Broadband Card: The Basicsº on 
page 31.

NOTE: If you have an older version of Sprint PCS Connection Manager and are 
experiencing problems during installation, use the Add/Remove Programs 
Utility (see page 51) to remove the older version of Sprint PCS Connection 
Manager. Then reinstall the current version of Sprint PCS Connection 
Manager from the Installation CD.
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Sect ion 2B

Inserting and Removing the Sprint Mobile 
Broadband Card

In This Section

l Inserting the Sprint Mobile Broadband Card

l Removing the Sprint Mobile Broadband Card

This section describes how to properly insert the Sprint Mobile Broadband Card 
and remove it from your PC.
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Inserting the Sprint Mobile Broadband Card

To insert the Sprint Mobile Broadband Card into a notebook:

1. With the picture label facing up, insert the Sprint Mobile Broadband Card into 
the PC Card slot.

When you insert the Sprint Mobile Broadband Card, the following should occur:

v The first time the card is inserted, Windows detects the card and installs the 
drivers for it. This may take a few minutes. Once completed, 
Sprint PCS Connection Manager should display ªDisconnected.º To connect to 
the network, click GO.

v If sound effects are enabled, the PC beeps.

v The PC Card icon appears in the system tray, if it is not already displayed for 
another card (and unless the feature has been disabled).

The Sprint Mobile Broadband Card is powered as soon as you insert it.

Windows XP Windows 2000
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Removing the Sprint Mobile Broadband Card

To remove the SprintMobile Broadband Card:

1. Exit Sprint PCS Connection Manager if it is open (page 42).

2. Click the Unplug and Eject Hardware icon in the system tray:

3. Click the entry for ªNEC PCI to USB Open Host Controllerº or ªStandard Enhanced 
PCI to USB Host Controller.º

4. If a dialog box appears notifying you that it is safe to remove the card, 
click OK, or click the Close button ( ).

5. Use your computer's PC Card ejector to eject the Sprint Mobile Broadband 
Card from the slot.

6. Remove the card from your computer's PC Card slot by gripping both sides of 
the card  and pulling straight out.

IMPORTANT! When inserting or removing your card, always grip the card by its sides. 
Gripping the card by its antenna may damage the card.

Correct Incorrect

Windows XP Windows 2000
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Sect ion 2C

Setting Up Service

In This Section

l Activating and Using Sprint PCS Service

l Preactivated Card

l Non-preactivated Card: Activation Wizard

l Data Provisioning (IOTA)

This section walks you through setting up service for your Sprint Mobile 
Broadband Card, after you have installed the SprintPCS Connection Manager 
software (page 16) and inserted the Sprint Mobile Broadband Card.
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Activating and Using Sprint PCS Service

Before using your Sprint Mobile Broadband Card, you must have a Sprint PCS 
wireless network account set up. The process of setting up an account is called 
activation.

When the Sprint Mobile Broadband Card is inserted and Sprint PCS Connection 
Manager is started, it will detect whether the card has been configured with an 
account (ªpreactivatedº). If it has not, the Activation Wizard starts automatically.

Preactivated Card

If you received your Sprint Mobile Broadband Card in the mail or purchased it at a 
Sprint Store, it probably has already been activated.

To prevent unauthorized use, preactivated cards may have been set with a security 
lock. If so, Sprint PCS Connection Manager displays the message ªDevice Locked.º

To unlock your SprintMobile Broadband Card:

1. Click the  icon. (If is not visible, click  to expand Sprint PCS Connection 
Manager.)

2. In the Enter User Lock Code window, enter your four-digit lock code, and click 
OK. For security purposes, the code is not visible as you type.

After unlocking your preactivated Sprint Mobile Broadband Card, it is ready for 
use. See ªUsing the Sprint Mobile Broadband Cardº on page 29.

Non-preactivated Card: Activation Wizard

If your card is not preactivated, please see the Getting Started guide included with 
your card.

If your Sprint Mobile Broadband Card is not preactivated, Sprint PCS Connection 
Manager automatically detects that no account has been configured when you 
run it for the first time. It then runs the Activation Wizard to guide you through 
the activation and configuration process.

To set up your account, you will be contacting Sprint.

Tip: If you can't recall your lock code, try using the last four digits of either your 
Social Security number or wireless phone number, or try 0000. If none of 
these work, call Sprint Customer Service at 1-888-211-4PCS (4727).
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Before you call Sprint, have these things ready:
v A phone

v Your Sprint Mobile Broadband Card

v Your Social Security number

v Your driver's license number

v The city and state where the device will be primarily used

v A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

v Your card's activation code (gives you access to configure the account)

v Your card's phone number (MDN)

v Your card's MSID (Mobile System ID) code, used for WLNP (Wireless Local 
Number Portability) and to determine whether you are ªhomeº or ªroamingº

Stepping Through the Activation Wizard
If the Activation Wizard has not started automatically:

1. Ensure the Sprint Mobile Broadband Card is inserted, and 
Sprint PCS Connection Manager is running. If Sprint PCS Connection Manager 
is not running, select:
(Windows XP) Start > All Programs > Sprint > Sprint PCS Connection Manager.
(Windows 2000) Start > Programs > Sprint > Sprint PCS Connection Manager.

Sprint PCS Connection Manager should display ªDisconnected.º

2. If Sprint PCS Connection Manager displays ªDevice Locked,º unlock the card 
(page 49).

3. If Sprint PCS Connection Manager displays ªDevice powered off,º power on 
the card (page 38).

4. Start the Activation Wizard: select MENU > Settings > Sprint PCS Vision - Sierra 
Wireless > Activation Wizard.

Once the Activation Wizard is running:

1. To begin activation of the Sprint Mobile Broadband Card, click Next.

2. Call Sprint at the phone number listed on the screen. Click Next.
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3. Give the account representative your ESN (Electronic Serial Number) or MEID 
(Mobile Equipment IDentifier) number as displayed by the Activation Wizard. 
Enter the activation code provided by the account representative and 
click Next.

4. Enter the phone number (no spaces or hyphens) and, if not the same value as 
the phone number, the MSID value given by the account representative, and 
then click Next.

A confirmation window will be displayed.

5. Confirm with the service representative that the information is correct. If it is, 
click Yes. If it isn©t, click No, and re-enter the information.

6. Click Finish to close the Activation Wizard.

7. Wait a few moments for the Sprint Mobile Broadband Card to automatically 
reset. Depending on your configuration, an IOTA session may automatically 
start (ªData Provisioning [IOTA],º below).

After Sprint sets up your account on the network, your Sprint Mobile Broadband 
Card should be configured and ready for use.

Data Provisioning (IOTA)

IOTA (Internet Over The Air), supported by some service providers (including 
Sprint), is an automated feature to perform account setup for you by making a 
connection to the CDMA network and using a secure Internet connection to 
download account parameters to your Sprint Mobile Broadband Card. To make 
this secure connection, IOTA requires that your computer support 128-bit 
encryption. (See ªHigh Encryption Requirementsº on page 9.)

Depending on your configuration, the first time Sprint PCS Connection Manager 
detects the activated card, an IOTA session may automatically start, during which 
status messages (ªUpdating User Profile¼º) are displayed.

After this first activation, there may be changes to your account that require 
updating the parameters in the Sprint Mobile Broadband Card. If this is needed:

1. In the Device Info & Diagnostics window (page 70), click Update Data Profile. 
(If this button is not displayed, eject and reinsert the card.)

2. In the IOTA Provisioning window, click Yes.

Your Sprint Mobile Broadband Card then retrieves the updates to your data 
services account.

Once the updates are successful, Sprint PCS Connection Manager is displayed 
(ªDisconnectedº). You can now connect to the network.
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Sect ion 2D

Getting Help

In This Section

l Visit Our Web Site

l Contact Sprint Customer Service

l Troubleshooting

This section describes where you can find more information on Sprint PCS 
Services, options, and troubleshooting problems you have encountered.
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Visit Our Web Site

Stop by www.sprint.com  and log on to get up-to-date information on Sprint PCS 
Services, options, and more.

You can also:

v Review coverage maps.

v Access your account information.

v Add additional options to your service plan.

v Check out frequently asked questions.

v And more.

Contact Sprint Customer Service

You can reach Sprint Customer Service by:

v Logging on to your account at www.sprint.com .

v Calling us toll-free at 1-888-211-4PCS (4727).

v Writing to us at Sprint Customer Service, P.O. Box 8077, 
London, KY  40742.

Troubleshooting

The Online Help for Sprint PCS Connection Manager (see page 47) includes 
descriptions of most common error messages. Look in the Contents under 
Troubleshooting.

For help with other problems:

v See ªTroubleshooting Tipsº on page 79.

v Consult the Sierra Wireless Web site at www.sierrawireless.com, where you will 
find an extensive knowledge base that can be searched to address most 
problems, and the Installation Troubleshooting wizard (in the Support & 
Download section).

v Contact Sprint as noted above.
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Sect ion 3A

Your Sprint Mobile Broadband Card: The Basics

In This Section

l Sprint PCS Connection Manager

l Starting Sprint PCS Connection Manager

l Start Sprint PCS Connection Manager Automatically

l Sprint PCS Connection Manager Window

l Connection States

l System Tray Connection States

l Determining the Type of Coverage

l Powering the card off/on

l Controlling the Sprint PCS Connection Manager Window

l Launching a Sprint Power Vision/Sprint PCSVision Connection

l Viewing the Amount of Data Transferred

l Ending a Connection

l Online Help

l Displaying Your Phone Number

l Security

l Accessing Links

l Uninstalling the Sprint PCS Connection Manager Software

Your Sprint Mobile Broadband Card is packed with features that simplify your life 
and expand your ability to stay connected to the people and information that are 
important to you. This section guides you through the basic features of your 
Sprint Mobile Broadband Card.
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Sprint PCS Connection Manager

Sprint PCS Connection Manager is the application that allows you to manage and 
monitor the high-speed Sprint Power Vision (1xEV-DO) and Sprint PCS Vision (1X) 
connection to the Sprint network. You use Sprint PCSConnection Manager to:

v Determine your signal strength and other network connection parameters (page 33).

v Initiate data calls (page 43).

v View call statistics (page 68) and messages (page 35).

v Customize features and options (page 58).

Starting Sprint PCS Connection Manager

To start SprintPCSConnection Manager:

1. Ensure the Sprint Mobile Broadband Card is inserted into your computer's PC 
Card slot, with the Sprint label facing up.

2. Double-click the program's icon ( ) on your desktop, or, from the Start menu 
on your Windows desktop, select:
(Windows XP) All Programs > Sprint > Sprint PCS Connection Manager.
(Windows 2000) Programs > Sprint > Sprint PCS Connection Manager.

When Sprint PCS Connection Manager is running, it places an icon ( ) in the 
system tray, usually at the right end of the taskbar. (See page 39.)

Start Sprint PCS Connection Manager Automatically

To set SprintPCSConnection Manager to start automatically (whenever your card is 
detected):

© From the General option of the Settings window (page 59), select Launch 
Connection Manager automatically.

Tip: You can also set Sprint PCS Connection Manager to launch automatically 
whenever your card is detected. (See the following section.)

Note: Changes to this setting apply only after you restart Windows.
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Sprint PCS Connection Manager Window

The text (for example, ªConnectedº shown in the screenshot above) and icon(s) in 
Sprint PCS Connection Manager indicate the connection state (page 35), and also 

(only when Disconnected) the lock state (page 47) (locked  or unlocked ).

Tip: You can also set the connection to launch automatically whenever available. 
(See ªGO automatically when readyº on page 62.) These settings provide an 
ªalways-onº connection, as long as you have network coverage.

Exit

Establish/Show/

Menu

hide
details cancel a

MinimizeMessage area Indicator area

connection
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Sprint PCS Connection Manager may display, depending on the connection state, 
some of the following icons:

CDMA network signal strength, indicated by the number of bars.

The ToolTip indicates the type of coverage you have (for example, 1X 
and/or 1xEV-DO), and the signal strength, in dBm.

You are roaming. Roaming charges may apply.

If this icon is flashing, you are in a non-preferred roaming area, and you 
may not be able to complete your calls.

Tip: You can change the roaming option ("Roam Mode"; for example, to 
disable roaming, select Sprint), and also enable the Roam Guard feature (from 
the Sprint PCS Vision Settings window; page 61).

1xEV-DO Rev. A transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

1xEV-DO Rev. 0 transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

1xEV-DO (Rev. 0 and Rev. A) transmit/receive icon: the data connection 
is dormant. The up and down arrows are gray.

1X transmit/receive icon: a data connection is active.

The up arrow is black and animated when data is being transmitted to 
the network.

The down arrow is black and animated when data is being received 
from the network.

1X transmit/receive icon: the data connection is dormant. The up and 
down arrows are gray.

Data optimization/compression is in use (page 64).
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Sprint PCS Connection Manager has the following buttons and text:

v Menu or the  button Ð Displays the Sprint PCS Connection Manager menu 
(page 54).

v  Ð Expands Sprint PCS Connection Manager and displays the amount of 
data transferred (when Connected), or, when Disconnected, the lock status of 

your card (locked  or unlocked ).

v  (Displayed when Sprint PCS Connection Manager is expanded) Ð Hides the 
amount of data transferred and the lock status of your card.

v  (upper right corner of the window) Ð Minimizes Sprint PCS Connection 
Manager (page 42).

v  Ð Exits Sprint PCS Connection Manager.

v GO Ð Starts the Sprint Power Vision/Sprint PCS Vision connection (page 43).

v Stop Ð Ends the connection (visible when a connection is established).

Connection States

Sprint PCS Connection Manager can display various connection/interaction states, 
including:

v No device

v Initializing

v Updating User Profile¼ (See ªData Provisioning [IOTA] on page 26.)

v Searching for service...

v Disconnected

v Connecting

v Connected

v Device Locked

v Device powered off

Note: The system tray icon also indicates the connection state (page 16).
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No device

Sprint PCS Connection Manager did not detect a SprintMobile Broadband Card. 
The GO button is unavailable.

Insert the Sprint Mobile Broadband Card. If it is already inserted, eject and reinsert 
it; wait a few moments. If this message is still displayed, uninstall (page 51) and 
reinstall Sprint PCS Connection Manager, or contact Sprint (page 27).

Initializing

Sprint PCS Connection Manager is attempting to establish communication with 
the Sprint Mobile Broadband Card.

Searching for service...

Sprint PCS Connection Manager is determining whether 1X/1xEV-DO service is 
available.

Disconnected

Sprint PCS Connection Manager is ready to make a connection to the network. The 

GO button is available; the signal strength icon ( ) and the roaming icon ( ) (if 
you're roaming) are visible. If Sprint PCS Connection Manager is expanded, the 

lock icon (  or ) is visible.

To connect to the network, click GO.

Connecting

Sprint PCS Connection Manager is establishing a connection to the network.
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Connected

The connection is established. In addition to the signal strength icon ( ) and the 

roaming icon ( ) (if you're roaming), the transmit/receive icon (  for 1xEV-DO 

Rev. A;  for 1xEV-DO Rev. 0;  for 1X) is also displayed. If image optimization/

compression is in use,  is also displayed (page 64).

If you expand Sprint PCS Connection Manager ( ), the amount of data 
transferred is shown. (See note on page 46.)

To end the connection, click Stop.

Device Locked

The card is locked, so that others cannot use the card and your account. To use 
most of the features, you must unlock the card (page 49).
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Device powered off

The card has been powered off (through Menu > Power Off Modem). To use the 
card, select Menu > Power On Modem.

For more information, see ªPowering the card off/onº on page 40.
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System Tray Connection States

Sprint PCS Connection Manager has an associated icon ( ) that appears in the 
system tray. The icon reflects the connection state.

Clicking the system tray icon toggles between displaying and minimizing 
Sprint PCS Connection Manager.

Right-clicking the icon displays the shortcut menu (page 56).

Determining the Type of Coverage

The ToolTip over the signal strength indicator ( ) indicates the type of coverage 
you have (for example, 1X [synonym of 1xRTT] or 1xEV-DO):

Sprint PCS Connection Manager is not ready to connect to the 
network. Your Sprint Mobile Broadband Card is either locked 
(ªDevice Lockedº; page 37), or not detected (ªNo deviceº; page 36), 
or powered off (ªDevice powered offº; page 38).

Disconnected Ð Sprint PCS Connection Manager is ready to make a 
connection to the network (page 36), or
Connecting Ð Sprint PCS Connection Manager is making a 
connection to the network (page 36).

Connected Ð Connection is established to the network; data 
transfer is in progress (page 37).

Dormant Ð Connection is established, but no data transfer is 
taking place.
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Powering the card off/on

If you are using your Sprint Mobile Broadband Card in an aircraft, hospital, or 
other environment where the radio modem of the card may cause interference, 
you can power off the modem (without ejecting the card), and still use other 
functions of your notebook computer.

This also allows you to conserve your notebook computer's battery.

To power off the modem:

1. Close any active data connection (page 46).

2. Select MENU > Power Off Modem.

When powered off, the menu option switches to Power On Modem, and 
Sprint PCS Connection Manager displays the message ªDevice powered off .º

To power on the modem:

© Select MENU > Power On Modem.

Tip: The type of coverage is also displayed in the lower left part of the Device Info 
& Diagnostics window under ªNetwork Serviceº (page 71).
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Controlling the Sprint PCS Connection Manager Window

Expanding Sprint PCS Connection Manager

Sprint PCS Connection Manager has two views: expanded, and non-expanded.

Non-expanded view:

To expand Sprint PCS Connection Manager, click . Sprint PCS Connection 
Manager now also displays the amount of data transferred during the current 

connection, and (only when Disconnected) the lock state of the card (locked  or 

unlocked ).

To change back to non-expanded view, click .
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Minimizing Sprint PCS Connection Manager
To save space on your screen for other programs, you can minimize the 
Sprint PCSConnection Manager:

© Click  (in the upper right corner of Sprint PCS Connection Manager).

± or ±

Click the Sprint PCS Connection Manager icon  in the system tray.

± or ±

Right-click the system tray icon and select Close Sprint PCS Connection Manager.

You can use the system tray icon to monitor the connection state (page 39).

Restoring Sprint PCS Connection Manager
To restore SprintPCSConnection Manager when it is minimized:

© Click the Sprint PCS Connection Manager icon  in the system tray. 

± or ±

Right-click the system tray icon and select Open Sprint PCS Connection Manager.

Exiting Sprint PCS Connection Manager
To exit Sprint PCSConnection Manager:

© In Sprint PCS Connection Manager, click Menu > Exit, or click the  button,

± or ±

Right-click the Sprint PCS Connection Manager icon  in the system tray 
and, from the shortcut menu, select Exit.

If a connection is in progress, a window is displayed asking whether you want to 
disconnect the call. To end the connection and close Sprint PCS Connection 
Manager, you must click Yes.

Sprint PCS Connection Manager exits, and the Sprint PCS Connection Manager 
icon disappears from the system tray.

Tip: You can set Sprint PCS Connection Manager to start minimized. (See ªStart 
in system trayº on page 60.)

Tip: You can prevent Sprint PCS Connection Manager from minimizing by setting 
ªAlways on topº (page 60).
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Launching a Sprint Power Vision/Sprint PCSVision 
Connection

To launch a connection:

© In Sprint PCS Connection Manager, click GO. (If GO is unavailable, see ªGO 
Button Is Unavailableº on page 81.)

When the connection is successfully established, the Sprint PCS Network welcome 
screen appears (unless you have turned off the display of the welcome screens; 
see ªAlways show Welcome Screensº on page 62).

Sprint PCS Connection Manager displays ªConnectedº (page 37).

You can now use your Web browser, perform data transfers, and so on.

To monitor the status of the connection, you can use the text (page 35) and icons 
(page 33) in Sprint PCS Connection Manager, and the icon in the system tray 
(page 39). You can also view the amount of data transferred (page 46).

Tip: You can optionally specify which application to automatically launch when 
the connection is established. (See ªAuto-launch upon network connectionº 
on page 45.)
You can also set the connection to launch automatically whenever available. 
(See ªGO automatically when readyº on page 62.) If you also set Sprint PCS 
Connection Manager to launch automatically (see ªLaunch Connection 
Manager automaticallyº on page 60), this can provide an ªalways-onº 
connection, as long as you have network coverage.
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Roam Guard

The Roam Guard feature, when enabled, displays a warning message if you are 
roaming and a data connection is established or about to be established. The 
message reminds you that roaming rates may apply.

From the window with the warning message, you can:

v Turn off the warning message for this data session only (#Do not ask again 
during this data session#).

v Continue with the data connection (#Roam#) (in which case you may be subject 
to roaming rates).

v End the data connection (#Cancel#).

To turn on the Roam Guard feature:

1. From the Sprint PCS Vision option of the Settings window, ensure Roam Mode 
is set to Automatic .

2. Select Roam Guard.

To permanently turn off the Roam Guard feature:

© From the Sprint PCS Vision option of the Settings window, clear Roam Guard.

Note: This feature is available only if Roam Mode is set to Automatic  (from the 
Sprint PCS Vision option of the Settings window;  page 61).
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Auto-launch upon network connection

You can optionally specify which application to automatically launch when a 
Sprint Power Vision/Sprint PCS Vision connection is established.

To specify which application to automatically launch:

1. Ensure Sprint PCS Connection Manager is running and not locked (page 48).

2. Ensure your Sprint Mobile Broadband Card is not powered off (page 38).

3. Select MENU > Settings > Sprint PCS Vision - Sierra Wireless.

4. Click Auto Launch.

5. In the Auto-Launch Options window, select one of the following:

n None Ð Do not auto-launch any application.

n Website Ð Auto-launch Internet Explorer. In the URL field, specify the Web 
site (such as http://www.sierrawireless.com) you want to view on 
connection.

n Microsoft VPN (PPTP) Connection Ð Auto-launch a Windows VPN connection. 
Type in the address of the VPN connection, or, from the drop-down list, 
select the VPN connection.

n Application (VPN client, etc.) Ð Auto-launch an installed VPN program, or any 
other program. In the field, enter the path to the program, or use the 
Browse button to locate the program.

The changes are applied the next time you launch a connection.

Note: This feature is in effect only when Sprint PCS Connection Manager is 
running.
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Viewing the Amount of Data Transferred

To view the number of bytes sent/received during the current connection:

© If Sprint PCS Connection Manager is not expanded, click the  button.

The number of bytes sent/received during the current connection is displayed, in 
three significant digits (such as 581 kb, 1.23 Mb, 1.81 Mb).

Once you end the connection, the figures are set to zero.

To hide the part of Sprint PCS Connection Manager that displays this information, 

click the  button.

Ending a Connection

To end a connection:

© In Sprint PCS Connection Manager, click STOP.

If you exit Sprint PCS Connection Manager while a connection is in progress, a 
window is displayed asking whether you want to disconnect the call. By clicking 
Yes, you can end the connection and exit Sprint PCS Connection Manager. (See 
ªExiting Sprint PCS Connection Managerº on page 42.)

Note: Even though the number of bytes sent/received is displayed while the 
connection is running, this is not necessarily the actual amount of data 
being transmitted across the network. Do not use this information to estimate 
billing.
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If you have enabled GO automatically when ready, manually disconnecting will 
leave the card disconnected. It will not reconnect until one of the following occurs:

v You make a connection through Sprint PCS Connection Manager

v You restart Sprint PCS Connection Manager

v You eject and reinsert the card

Online Help

Sprint PCS Connection Manager includes extensive online help to provide 
operating hints and step-by-step instructions for getting the most from your 
Sprint Mobile Broadband Card.

With Sprint PCS Connection Manager running, you can access online help in 
several ways:

v Press <F1> in any window.

v From the Sprint PCS Connection Manager window, select MENU > Help.

v Right-click the system tray icon ( ) and select Help.

v Click the Help button available in many windows.

The help file has a table of contents and an index.

Displaying Your Phone Number

You can view your phone number in the Device Info & Diagnostics window 
(Menu > Device Info & Diagnostics).

Security

When Disconnected, you can lock your Sprint Mobile Broadband Card so that 
others cannot use the card and account. A four-digit lock code is needed to unlock 
the card.

You can set the Sprint Mobile Broadband Card to lock: 

v Whenever Sprint PCS Connection Manager is started (page 49), or 

v Immediately (without restarting Sprint PCS Connection Manager) Ð useful if 
you are lending your Sprint Mobile Broadband Card and PC or leaving it for a 
short time (page 48).
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Initial Lock Code 

The initial lock code value is determined by your service provider. 

For service provider configurations that do not require account activation, a 
default lock code is set at the factory to a value determined by the service 
provider. For assistance, contact Sprint (page 27). 

Configurations that use the Activation Wizard set the initial lock code to the last 
four digits of your account phone number whenever a new phone number is 
activated.

After activation, you can change the lock code (page 50) from the initial value to 
any four-digit code you choose. (See ªWarning Regarding the Lock Codeº below.)

Warning Regarding the Lock Code

If you lock the Sprint Mobile Broadband Card and forget the lock code, you will not 
be able to use the card until you receive assistance from Sprint.

Behavior When the Sprint Mobile Broadband Card Is Locked

When the Sprint Mobile Broadband Card is locked, you can:

v Unlock the card (page 49).

v Power off the modem (page 40).

When the card is locked, you cannot: 

v Make data connections (the GO button is unavailable).

v Run the Activation Wizard.

Lock the Card

To lock the Sprint Mobile Broadband Card immediately: 

1. End any active connection. (You can lock the card only when Disconnected; 
page 36.)

2. If Sprint PCS Connection Manager is not expanded, click  to expand it.

Note: The security lock code is reset to the last four digits of the phone number 
whenever an account is activated. This may change a custom value you 
have set.

Warning: If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.
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3. Click the  icon.

4. In the Enter User Lock Code window, enter the lock code, and click OK.

When the card is locked, Sprint PCS Connection Manager displays ªDevice Locked,º 

and the lock icon is now . The GO button is unavailable.

Lock Upon Startup of Sprint PCS Connection Manager
To set the SprintMobile Broadband Card to lock as soon as Sprint PCSConnection 
Manager starts up: 

1. End any active connection. (You can lock the card only when Disconnected; 
page 36.)

2. If Sprint PCS Connection Manager is not expanded, click  to expand it.

3. Click the lock icon (  or , depending on the current lock status).

4. In the Enter User Lock Code window, enter the lock code, and select Relock 
modem when program exits.

5. Click OK.

Unlock the Card

When locked, Sprint PCS Connection Manager displays ªDevice Locked,º and the 

lock icon is .

To unlock the card: 

1. If Sprint PCS Connection Manager is not expanded, click  to expand it.

2. Click the  icon.

3. In the Enter User Lock Code window, enter the lock code, and click OK.

When the card is unlocked, Sprint PCS Connection Manager no longer displays 

ªDevice Locked,º and the lock icon is .

Tip: You can also set the card to be locked upon startup of Sprint PCS Connection 
Manager, as described next.

Note: This setting takes effect only after you exit and restart Sprint PCS 
Connection Manager.
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Change the Lock Code

To change the lock code:

1. In the Sprint PCS Vision settings window, click User Lock Change.

The Change User Lock Code window is displayed:

2. Enter the current lock code.

3. Enter a new four-digit lock code.

4. Enter the new lock code for confirmation.

5. Click OK.

Accessing Links

For your convenience, Sprint PCS Connection Manager includes links to Sprint PCS 
products and services. To access these links:

1. In Sprint PCS Connection Manager, click Menu.

2. Select Links.

Warning:  If you forget the lock code, you will not be able to use the card until you 
receive assistance from Sprint.

Note: From the Links menu you cannot add or remove links. To do this, use your 
Web browser.
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Uninstalling the Sprint PCS Connection Manager Software

To remove the Sprint PCS Connection Manager software from your computer, use 
the Add/Remove Programs Utility built into your Windows operating system.

1. Exit Sprint PCS Connection Manager (page 42).

2. Eject the Sprint Mobile Broadband Card. (See ªRemoving the Sprint Mobile 
Broadband Cardº on page 21.)

3. Go to Start > Settings > Control Panel and select Add/Remove Programs.

The Windows Add/Remove Programs utility will start. Be sure the Change or 
Remove Programs feature is selected (default).

4. From the list, select Sprint PCS Connection Manager, and click Remove.
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Sect ion 3B

Menu Options

In This Section

l Sprint PCS Connection Manager Menu

l System Tray Menu

This chapter describes each menu option you may encounter while using your 
Sprint Mobile Broadband Card and the Sprint PCS Connection Manager software.
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Sprint PCS Connection Manager Menu

Clicking Menu or the  button, located in the upper left corner of 
Sprint PCS Connection Manager, displays the Sprint PCS Connection Manager 
menu.

The following table describes the menu options:

Note: Depending on your configuration and settings, not all menu options might 
be shown or enabled as described here.

Tip: You can also display the menu by positioning the cursor over the Menu text 
or  button and then pressing the spacebar or Enter key on your keyboard. 
To hide the menu, press Esc, or click outside the menu.

Menu Item Description

Alert Log View a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining 
connections. 

See ªViewing Alertsº on page 69.

Connection 
History

View a record of connections established using your 
Sprint Mobile Broadband Card (unavailable if the Connection 
History is empty, or if Keep Connection History [page 60] is not 
selected).

See ªViewing the Connection Historyº on page 68.
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Device Info & 
Diagnostics

View information about your Sprint Mobile Broadband Card, 
and run diagnostic tests. 

See ªRunning Diagnosticsº on page 70.

Power Off 
Modem

Power off your Sprint Mobile Broadband Card.

See ªPowering the card off/onº on page 40.

Software 
Updates

Retrieve updates for Sprint PCS Connection Manager and your 
Sprint Mobile Broadband Card. 

See ªUpdating the Softwareº on page 72.

Links  Access links to Sprint PCS products and services. 

See ªAccessing Linksº on page 50.

Help Display the online Help, which has operating hints and step-by-
step instructions for getting the most from your Sprint Mobile 
Broadband Card. 

See ªOnline Helpº on page 47.

About 
Sprint PCS 
Connection 
Manager

Display brief information about the Sprint PCS Connection 
Manager software. To close the window, click anywhere inside it. 

See ªAbout Sprint PCS Connection Managerº on page 73.

Settings Change the settings for Sprint PCS Connection Manager. 
Contains submenu items:

v General: See ªGeneral Settingsº on page 59.

v Sprint PCS Vision - Sierra Wireless: See ªSprint PCS Vision 
Settingsº on page 61.

v Optimization : See ªOptimization Settingsº on page 64.

Exit  Exits Sprint PCS Connection Manager.

Menu Item Description
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System Tray Menu

When you right-click the system tray icon ( ), a shortcut menu is displayed:

The following table describes the menu options:

Menu Item Description

Open/Close 
Sprint PCS 
Connection 
Manager

Minimize Sprint PCS Connection Manager (Close), or 
restore (Open) if Sprint PCS Connection Manager is 
minimized.

Help Display the online Help.

About 
Sprint PCS 
Connection 
Manager

Display brief information about the Sprint PCS Connection 
Manager software. To close the window, click anywhere 
inside it.

Exit Exit Sprint PCS Connection Manager.
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Sect ion 3C

Changing the Settings of Sprint PCS 
Connection Manager

In This Section

l Settings Window

l General Settings

l Sprint PCSVision Settings

l Optimization Settings

This chapter describes the windows from which you can change the settings for 
Sprint PCS Connection Manager.
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Settings Window

From the Settings window, you can specify the settings for Sprint PCS Connection 
Manager.

1. In Sprint PCS Connection Manager, click Menu.

2. Select Settings.

3. From the drop-down list, select one of the following categories of settings:

n General (general behavior of Sprint PCS Connection Manager)

n Sprint PCS Vision - Sierra Wireless (behavior of your Sprint Power Vision/
Sprint PCS Vision connection)

n Optimization (bandwidth optimization level used by your Sprint Power 
Vision/Sprint PCS Vision connection)

4. Make the appropriate changes to the settings (described in the following 
pages).

5. To change other settings, repeat steps 3 and 4.

6. Click OK.

Note: Temporarily unavailable, if you have powered off the device (page 40).

Note: Changes to the setting Launch Connection Manager automatically apply only 
after you restart Windows. Changes to the setting Start in system tray apply 
only after you exit and restart Sprint PCS Connection Manager.

Tip: You can also access the Settings window from the Connection History 
window: click File > Settings.
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General Settings

From the General option of the Settings window, you can specify settings that 
affect the general behavior of Sprint PCS Connection Manager.
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The following table describes the options:

Menu Item Description

Play sound 
effects

Play a clicking sound whenever an action is made in 
Sprint PCS Connection Manager.

Always on 
top

Keep Sprint PCS Connection Manager visible on your screen 
regardless of which applications are open.

Start in 
system tray

Have Sprint PCS Connection Manager start (minimized) in the 
system tray on startup. (See ªRestoring Sprint PCS Connection 
Managerº on page 42.)

Keep 
Connection 
History

Have Sprint PCS Connection Manager keep a log of your data 
connections (page 68).

Launch 
Connection 
Manager 
automatically

Have Sprint PCS Connection Manager start automatically 
(when your card is detected).

Tip: You can also set the Sprint Power Vision/Sprint PCSVision 
connection to launch automatically whenever available (see ªGO 
automatically when readyº on page 62). These settings provide an 
ªalways-onº connection, as long as you have network coverage.

Check for 
updates once 
per month

Have Sprint PCS Connection Manager automatically check for 
software updates (page 72).

Check Now Check for software updates immediately.
Note: During the software update, Sprint PCS Connection Manager 
will exit. Before you initiate the software update, finish any Web 
browsing, data transfers, and so on.

Note: Changes to the setting Launch  Connection Manager automatically apply only 
after you restart Windows. Changes to the setting Start in system tray apply 
only after you exit and restart Sprint PCS Connection Manager.
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Sprint PCSVision Settings

From the Sprint PCS Vision option of the Settings window, you can change the 
behavior of your Sprint Power Vision/Sprint PCS Vision connection.
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The following table describes the options:

Menu Item Description

Always show 
Welcome 
Screens

Display a welcome screen upon a successful connection to the 
Sprint Power Vision/Sprint PCS Vision network.

GO 
automatically 
when ready

Automatically connect to the Sprint PCS Network after 
Sprint PCS Connection Manager starts, or whenever 
Sprint PCS Connection Manager loses the network 
connection.

Tip: You can also set Sprint PCS Connection Manager to start 
automatically (see ªLaunch Connection Manager automaticallyº on 
page 60). These settings provide an ªalways-onº connection, as long 
as you have network coverage.

Automatic Attempt a Sprint Power Vision (1xEV-DO) connection and, if 
not successful, attempt the slower Sprint PCS Vision (1X) 
connection.

1xEV-DO 
Only

Attempt only a Sprint Power Vision (1xEV-DO) connection.

Note: When in an area that has only Sprint PCS Vision (1X) coverage, 
you won't be able to connect to the network.

1X Only Attempt only a Sprint PCS Vision (1X) connection (even when 
you are in Sprint Power Vision [1xEV-DO] coverage, which 
provides faster data transmission speeds).

Note: When in an area that has only Sprint Power Vision (1xEV-DO)  
coverage, you won't be able to connect to the network.

Sprint Disable roaming when Sprint coverage is unavailable. You will 
be able to connect only when Sprint coverage is available.

Automatic Allow roaming when Sprint coverage is unavailable.
Note: Roaming rates will apply. Roam Guard (page 44) can remind 
you of this.

Roam Only Allow only roaming.

Note: Roaming rates will apply. Roam Guard (page 44) can remind 
you of this.
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Roam Guard Display a warning message when you are about to establish a 
data connection while roaming. For more information, see 
ªRoam Guardº on page 44.

Available only if Roam Mode is set to Automatic (page62).
Note: If you proceed with the data connection, roaming rates will 
apply.

Activation 
Wizard

Used only when activating a Sprint Mobile Broadband Card, or 
when changing your card's phone number (page 24).

User Lock 
Change

Change the security lock code of the Sprint Mobile Broadband 
Card (page 50).

Auto Launch Optionally specify which application to automatical ly launch 
when a connection is established.

See ªAuto-launch upon network connectionº on page 45.

Menu Item Description
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Optimization Settings

The Sprint Mobile Broadband Card supports bandwidth optimization ± a 
combination of data compression, TCP/IP optimization and caching. When the 
related software is installed, the Sprint Mobile Broadband Card uses bandwidth 
optimization whenever possible (subject to network availability); when 

optimization is in use, the  icon is displayed in Sprint PCS Connection Manager.

The improvement in your perceived system speed depends on the nature of your 
application. Limitations to bandwidth optimization include minimal 
improvements with email applications (page 77).

From the Optimization option of the Settings window, you can set the bandwidth 
optimization level used by your Sprint Power Vision/Sprint PCS Vision connection.

To enable optimization:

© Select Bandwidth Optimization On .

Note: This window is available only if the optimization client was installed (page 17).
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To adjust the level of optimization:

© Use the slider (under Image Compression).

n For increased system speed, move the slider towards Fastest. This may result 
in lower-quality graphics.

n For highest-quality graphics, move the slider towards Highest Quality. This 
may result in a lower system speed.

Do not change the Protocol Compression settings, unless you are very familiar with 
how these protocols work, or a Sprint representative instructs you to change them.
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Sect ion 3D

Tools

In This Section

l Viewing the Connection History

l Viewing Alerts

l Running Diagnostics

l Updating the Software

l About Sprint PCS Connection Manager

This chapter describes various features you can use, to view information about 
the Sprint Mobile Broadband Card and the Sprint PCS Connection Manager 
software.
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Viewing the Connection History

Connection History displays a record of connections established using your 
Sprint Mobile Broadband Card. You can sort records by connection name to easily 
distinguish between personal and business usage.

From this window you can also access the Settings window (page 58) (File > 
Settings).

To view the Connection History:

1. In Sprint PCS Connection Manager, click Menu.

2. Select Connection History.

To sort the entries:

© Click the button that contains the title of the colu mn you want to sort by. (You 
can reverse the sort order by clicking the button again.)

± or ±

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

To copy one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries; to select all entries, use Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email).

Note: For connections to be recorded, Keep Connection History must be enabled 
(page 60).
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To delete all entries:

© Click the Clear button.

To delete one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries.)

2. Select Edit > Delete.

Viewing Alerts

The Alert Log displays a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining connections. You can use 
the Alert Log to help isolate and resolve connection issues.

To view the Alert Log:

1. In Sprint PCS Connection Manager, click Menu.

2. Select Alert Log. (This menu option is unavailable if the alert log is empty.)

To sort the entries:

© Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.) 

± or ±

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.
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To copy one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries; to select all entries, use Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email).

To delete all entries:

© Click the Clear button.

To delete one or more entry:

1. Select the entries. (Click a single entry, or use Ctrl-click or Shift-click to select 
multiple entries.)

2. Select Edit > Delete.

Running Diagnostics

To identify problems connecting to the Sprint PCS Network, use the Device 
Info & Diagnostics window. Device Info & Diagnostics evaluates issues with your 
USB port, port configuration, network signal strength, the Sprint PCS Network, 
Sprint PCS Connection Manager, and more. Once the program runs a diagnostics 
check, it recommends solutions.

The program also displays information such as your phone number.

Results of the diagnostics can be shared with a Sprint Customer Service Specialist, 
to assist that person with troubleshooting.

To access the Device Info & Diagnostics window:

1. Ensure the Sprint Mobile Broadband Card is inserted.

2. In Sprint PCS Connection Manager, click Menu.

3. Select Device Info & Diagnostics.
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The tests automatically start when the window opens.

From the Device Info & Diagnostics window, you can view system information 
(page 72) and save the system information to an RTF file.

From the Device Info & Diagnostics window, you can also update parameters in 
your Sprint Mobile Broadband Card:

© Click Update Data Profile. (If this button is not displayed, eject and reinsert 
the card.)
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Displaying System Information

The System Information window displays:

v System Parameters: Information about your computer hardware and software.

v Installed Files: Files related to Sprint PCS Connection Manager.

v Device Info & Diagnostics: Information about the Sprint Mobile Broadband Card 
(including its phone number), and results of various tests.

To display system information:

1. Select Menu > Device Info & Diagnostics.

2. In the Device Info & Diagnostics window, click System Information.

To save the information to a file (for example, if you are requested to send the report to 
your service provider representative):

1. In the System Information window, click Create Report.

2. Specify a file name and path.

3. Click Save.

Updating the Software

From time to time, Sprint may release updates for Sprint PCS Connection Manager 
and your Sprint Mobile Broadband Card. These updates might add features or 
improve network performance.

To update the software:

1. Ensure you have a network connection.

2. In Sprint PCS Connection Manager, click Menu. Select Software Updates. 

± or ±

From the General option of the Settings window (page 58), click Check Now.

You can also set the software to automatically check for updates once a month:

1. In Sprint PCS Connection Manager, click Menu and then select Settings.

2. Select Check for updates once per month.

Note: During the software update, Sprint PCS Connection Manager will exit. 
Before you initiate the software update, finish any Web browsing, data 
transfers, and so on.
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About Sprint PCS Connection Manager

The About Sprint PCS Connection Manager window displays information about 
the Sprint PCS Connection Manager software.

To display this window:

© In Sprint PCS Connection Manager, click Menu and then select About 
Sprint PCS Connection Manager. 

± or ±

Right-click the Sprint PCS Connection Manager icon ( ) in the system tray 
and, from the shortcut menu, select About Sprint PCS Connection Manager.

To close this window, click anywhere inside it.

Tip: To display more information, you can run diagnostics (page 70).
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Sect ion 3E

Frequently Asked Questions

In This Section

l What is Sprint PCS Connection Manager?

l If the connection is ªalways on,º am I always being billed?

l How fast is the connection with Sprint PCS Connection Manager?

l Can I connect to a dial-up account like AOL or EarthLink?

l Once I connect to the Nationwide Sprint PCS Network, how do I access my corporate 
network through a VPN?

l How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?

l Why won©t my laptop go into hibernation mode when using my 
Sprint Mobile Broadband Card?
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What is Sprint PCS Connection Manager?

Sprint PCS Connection Manager is software that lets you connect to the Sprint 
Power Vision/Sprint PCS Vision network. Sprint PCS Connection Manager takes 
advantage of the increased data speeds offered by the Nationwide Sprint PCS 
Network.

If the connection is ªalways on,º am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.

How fast is the connection with Sprint PCS Connection 
Manager?

The Sprint PCS Network allows you to connect to the Internet at speeds of up to 
3.1 Mbps (1xEV-DO Rev. A), 2.4 Mbps (1xEV-DO Rev. 0), or 144 kbps (1X). Average 
connection speeds are:
For 1xEV-DO Rev. A: between 600 and 1300 kbps downlink from the network, and 
between 300 and 400 kbps uplink to the network;
For 1xEV-DO Rev. 0: between 400 and 700 kbps downlink from the network, and 
between 40 and 80 kbps uplink to the network;
For 1X: between 40 and 80 kbps.

This is faster than a dial-up connection. Bandwidth optimization on the 
Nationwide Sprint PCS Network (page 64) provides increased data throughput for 
certain applications and protocols.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.
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Once I connect to the Nationwide Sprint PCS Network, how 
do I access my corporate network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate username and 
password to gain access. For support, contact your company help desk.

How can I optimize my settings to achieve the fastest 
speeds and conserve data when accessing my corporate 
network?

Depending on your corporate email client, you can optimize your settings by 
doing the following:

v Work in ªofflineº mode, and connect only when you need to send or receive 
email.

v Remove the Preview Pane, or use the AutoPreview for headers only.

v Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, access the Microsoft white paper at:
www.microsoft.com/office/outlook/evaluation/perform .doc.

See also Optimization Settings (page 64).

Why won©t my laptop go into hibernation mode when 
using my Sprint Mobile Broadband Card?

If you©re using Windows! 2000, you need to upgrade to Service Pack 4 from 
www.microsoft.com .
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Sect ion 3F

Troubleshooting Tips

In This Section

l Problems, Causes, and Solutions

l GO Button Is Unavailable

l Searching for Service

l Cannot Connect to the Sprint Power Vision/Sprint PCSVision Network

l Could Not Prepare Data Services

l Unable To Prepare Data Services

l Sprint PCS Connection Manager Stopped Working After Upgrading Windows

This section helps you diagnose and solve common problems you may experience 
while using your Sprint Mobile Broadband Card and the Sprint PCS Connection 
Manager software.
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Problems, Causes, and Solutions

When properly installed, the Sprint Mobile Broadband Card is a highly reliable 
product.

Most problems are caused by one of these issues:

v Network coverage is not available (because of your ªNetwork Modeº settings 
[page 61], or because you are outside the Nationwide Sprint PCS Network, or 
because of an account or network problem).

v The driver was not properly installed because of a problem with your notebook 
computer's PC Card.

v System resources required by the card are being used by other devices.

Tips when troubleshooting problems with your Sprint Mobile Broadband Card and 
software:

v Ensure your card is inserted, not locked (page 48), and not powered off 
(page 38).

v To determine the connection status, use the icons in the system tray (page 39), 
and icons and messages in Sprint PCS Connection Manager (page 33 and 
page 35).

v The alert log might indicate the nature of the problem (page 69).

v Run diagnostic tools supplied with Sprint PCS Connection Manager (page 70).

v Check the Frequently Asked Questions (page 75).

v Use the resources listed in ªGetting Helpº (page 27).

v Has Sprint PCS Connection Manager stopped working after you've upgraded to 
a different version of Windows (page 83)?

If, after reading this section, you are unable to resolve a problem, please visit 
www.sprint.com  or contact Sprint Customer Service. (See ªGetting Helpº on 
page 27.)
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GO Button Is Unavailable

Ensure the Sprint Mobile Broadband Card is properly inserted, not locked 
(page 48), and not powered off (page 38).

If Sprint PCS Connection Manager displays ªSearching for serviceº for a long 
period of time (for example, several minutes), see ªSearching for Serviceº below.

If Roam Mode (from the Sprint PCS Vision option of the Settings window) is set to 
Sprint, ensure you are not roaming, or change the setting. (You may be subject to 
roaming rates.) See page 62.

Searching for Service

If Sprint PCS Connection Manager displays ªSearching for serviceº for a long 
period of time (for example, several minutes), try one of the following: 

v Try re-orienting your computer.

v If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

v If Roam Mode (from the Sprint PCS Vision option of the Settings window) is set 
to Sprint: Ensure you are within the Sprint Power Vision/Sprint PCS Vision 
network coverage area, or change the Roam Mode setting. (You may be subject 
to roaming rates.)

v If Roam Mode (from the Sprint PCS Vision option of the Settings window) is set 
to Roam Only: Ensure you are roaming, or change the Roam Mode setting.

v If Network Mode (from the Sprint PCS Vision option of the Settings window) is 
set to 1X Only, and only 1xEV-DO coverage is available: Either move to an area 
that has 1X coverage, or change the setting to Automatic  or 1xEV-DO Only.

v If Network Mode (from the Sprint PCS Vision option of the Settings window) is 
set to 1xEV-DO Only, and only 1X coverage is available: Either move to an area 
that has 1xEV-DO coverage, or change the setting to Automatic  or 1X Only.

v Check with Sprint Ð a network or account problem may be preventing the 
Sprint Mobile Broadband Card from obtaining service.
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Cannot Connect to the Sprint Power Vision/
Sprint PCSVision Network

If you©re having problems connecting, or there©s no Sprint Power Vision (1x-EVDO) 
coverage in your area: set Network Mode (from the Sprint PCS Vision option of the 
Settings window) to 1X Only, and try to establish a connection.

If the connection is dropped as soon as it is established:

1. Select:

(Windows XP) Start > Control Panel > Network Connections

(Windows 2000) Start > Settings > Control Panel > Network and Dial-Up 
Connections

2. Right-click Sprint PCS Vision - Sierra Wireless, and select Properties.

3. Select the Networking tab.

4. Select Settings.

5. Ensure that ªEnable LCP Extensionsº and ªNegotiate multi-link for single link 
connectionsº are not selected.

6. Click OK.

Could Not Prepare Data Services 

See ªUnable To Prepare Data Servicesº below.

Unable To Prepare Data Services

The Sprint Mobile Broadband Card was unable to access the IOTA server to obtain 
data account parameters for you. This may be because the signal strength is poor  
or because the IOTA server is not responding.

v Confirm you have sufficient signal strength. Try the actions listed for 
ªSearching for Serviceº (page 81).

v Contact Sprint for assistance (page 27).

This message may indicate that your system does not support 128-bit encryption 
for high-security access to data provisioning. You will not be able to complete the 

Note: The message may appear as ªCould not prepare data services. Please contact...º
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activation of data services until you upgrade your system's security. (See ªHigh 
Encryption Requirementsº on page 9.)

Sprint PCS Connection Manager Stopped Working After
Upgrading Windows

If you upgrade to a different version of Windows, Sprint PCS Connection Manager 
will not work.

Before you upgrade Windows, or if you've upgraded Windows and 
Sprint PCS Connection Manager stopped working:

1. Uninstall Sprint PCS Connection Manager (page 51).

2. Upgrade Windows.

3. Reinstall Sprint PCS Connection Manager (page 15).

Note: After the following steps, any changes you made to Sprint PCS Connection 
Manager settings will be lost; you will have to re-apply the changes.
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Sect ion 4A

Technical Specifications

In This Section

l LED Operation

l Radio Frequency and Electrical Specifications

l Software Specifications

l Environmental Specifications

l Mechanical Specifications

This section describes the LED and various specifications of your Sprint Mobile 
Broadband Card.
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LED Operation

The AirCard! 595 PC Card has two LED light bars near the antenna end of the card. 
Both LED light bars operate as follows:

LED Behavior Indicates

Off The card has no power.  The card may not be 
completely inserted into the computer, or the 
computer may be in suspend mode (which powers 
down the card).

Red, blinking slowly The card is powering up, or no service is available. See 
ªSearching for Serviceº on page 81.

Solid blue The card has power, has found a signal, and is ready to 
connect.

Blue, blinking slowly The card is sending or receiving dataÐa 1X data 
session is in progress.

Blue, blinking rapidly The card is sending or receiving dataÐa 1xEV-DO 
(Rev. 0 or Rev. A) data session is in progress.

Solid red An error has occurred, or no signal was found. Eject the 
card (page 21) and reinsert it.
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Radio Frequency and Electrical Specifications

Approvals Compliant with:

IS-2000 Release 1.0 (CDMA (1X), IS-707-A Data, IS-856 
(CDMA 1xEV-DO), IS-866, IS-878, IS-890, 
CDMA Developers Group

FCC (ID: N7NAC595)

Industry Canada  (ID: 2417C-AC595)

Voltage +3.3 Vdc from PCMCIA Slot

Current Maximum:  1 A

Typical data call current (talk mode):

370 mA (1X)

420 mA (1xEV-DO)

Standby: 120 mA (1xEV-DO/IS2000 hybrid mode)

Transmitter 
power

200 mW (+23 dBm)

Transmit PCS: 1805 to 1870 MHz

Cellular: 824 to 849 MHz

Receive PCS: 1715 to 1780 MHz

Cellular: 868 to 894 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

$150 Hz
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Software Specifications

CDMA 
specification

IS - 2000 Release 0

Data service IS - 707A

SMS (IS-637) Not supported

FAX Not supported

IOTA Supported

OTASP (IS-683A, 
IS-683B, IS-683C)

Supported

OTAPA Supported

PRL (preferred 
roaming list)

Supported

Authentication Supported

Voice Not supported

NAM Single

E911 & Position 
Location

Not supported

TTY/Accessibility Not supported

Mobile IP Supported
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Environmental Specifications

Mechanical Specifications

Operating 
temperature

-30 to +60%C (ambient, outside PCMCIA enclosure)

Storage 
temperature

-30 to +65%C

Humidity 95*, non-condensing

Vibration 15 g peak 10 to 2000 Hz (non-operating)

Drop 30º (76.2 cm) onto vinyl covered concrete 

Dimensions
(W x L x H)

130.5 mm x 58 mm x 12.7 mm

(Height of PC Card slot portion: 5mm)

Power button Not supported

Headset jack Not supported

LED Red/blue
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Sect ion 4B

Regulatory Information

In This Section

l Regulatory Notices

l Patents

l Trademarks

l Copyright

l Limitation of Liability

l Additional Information and Updates

This section contains important regulatory notices about your Sprint Mobile 
Broadband Card, and also patent and other information.
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Regulatory Notices

The design of the AirCard 595 complies with U.S. Federal Communications 
Commission (FCC) and Industry Canada (IC) guidelines respecting safety levels of 
radio frequency (RF) exposure for portable devices, which in turn are consistent 
with the following safety standards previously set by Canadian, U.S. and 
international standards bodies:

v ANSI / IEEE C95.1-1999, IEEE Standard for Safety Levels with Respect to Human 
Exposure to Radio Frequency Electromagnetic Fields, 3kHz to 300 GHz

v National Council on Radiation Protection and Measurements (NCRP) Report 86, 
1986, Biological Effects and Exposure Criteria for Radio Frequency 
Electromagnetic Fields

v Health Canada, Safety Code 6, 1999, Limits of Human Exposure to Radio 
frequency Electromagnetic Fields in the Frequency Range from 3 kHz to 300 GHz

v International Commission on Non-Ionising Radiation Protection (ICNIRP) 1998, 
Guidelines for limiting exposure to time-varying electric, magnetic, and 
electromagnetic fields (up to 300 GHz)

FCC ID: N7NAC595

CAUTION: The AirCard 595 has been tested for compliance with FCC/IC RF 
exposure limits in the laptop computer(s) configurations with the side loading PC 
Card slot and can be used in laptop computers with substantially similar physical 
dimensions, construction, and electrical and RF characteristics. This PC card must 
not be colocated or operated in conjunction with any other antenna or 
transmitter. Use of this device in any other configuration may exceed the FCC RF 
Exposure compliance limit. Note: If this PC Card is intended for use in any other 
portable device, you are responsible for separate approval to satisfy the SAR 
requirements of Part 2.1093 of FCC rules.

Where appropriate, the use of the equipment is subject to the following 
conditions:

WARNING (EMI) - United States FCC Information - This equipment has been tested 
and found to comply with the limits for a class B computing device peripheral, 
pursuant to Parts 15, 22, and 24 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation.

This equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instructions, may cause harmful 
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interference to radio communication. However, there is no guarantee that 
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

v Reorient or relocate the receiving antenna

v Increase the separation between the equipment and receiver

v Connect the equipment into an outlet on a circuit different from that to which  
the receiver is connected

v Consult the dealer or an experienced radio/TV technician for help

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that 
may cause undesirable operations.

FCC guidelines stipulate that the antenna should be more than 1.7 cm from the 
user.

The highest reported SAR values of the Sprint Mobile Broadband Card by Sierra 
Wireless (AirCard 595) are:

1. Separation distance of at least 1.7 cm needs to be maintained to user's lap 
with AirCard 595 inserted into the bottom PC Card slot of the laptop computer 
(1.345 mW/g).

CAUTION: Any changes or modifications not expressly approved by Sprint 
Communications Company L.P. could void the user's authority to use the 
equipment.

WARNING (EMI) - Canada: This digital apparatus does not exceed the Class B limits 
for radio noise emissions from digital apparatus as set out in the interference 
causing equipment standard entitled ªDigital Apparatus,º ICES-003 of the 
Department of Communications.

Cet appareil num=rique respecte les limites de bruits radio=lectriques applicables 
aux appareils num=riques de Classe B prescrites dans la norme sur le mat=riel 
brouilleur: ªAppareils Num=riques,º NMB-003 =dict=e par le ministre des 
Communications.
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If you have purchased this product under a United States Government contract, it 
shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense 
Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions Regulations (FARs) 
Section 52.227-19 for civilian agency contracts or any successor regulations. If 
further government regulations apply, it is your responsibility to ensure 
compliance with such regulations.

Information pertaining to OEM customers

The AirCard 595 PC Card has been granted modular approval for mobile 
applications. Integrators may use the AirCard 595 in their final products without 
additional FCC/IC certification if they meet the following conditions. Otherwise, 
additional FCC/IC approvals must be obtained.

1. At least 20 cm separation distance between the antenna and the user's body 
must be maintained at all times.

2. To comply with FCC/IC regulations limiting both maximum RF output power 
and human exposure to RF radiation, the maximum antenna gain must not 
exceed 5.65 dBi in the Cellular band and 4.35 dBi in the PCS band.

3. The AirCard 595 card and its antenna must not be colocated with any other 
transmitter or antenna within a host device.

4. A label must be affixed to the outside of the end product into which the 
AirCard 595 is embedded, with a statement similar to the following:

This device contains TX FCC ID: N7NAC595.

This equipment contains equipment certified under IC: 2417C-AC595.

5. A user manual with the end product must clearly indicate the operating 
requirements and conditions that must be observed to ensure compliance 
with current FCC/IC RF exposure guidelines.

The end product with an embedded AirCard 595 card must pass the unintentional 
emission testing and properly authorized per FCC Part 15 requirements.

Note: If this PC Card is intended for use in a portable device, you are responsible 
for separate approval to satisfy the SAR requirements of FCC Part 2.1093 
and IC RSS-102.
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Patents
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Trademarks

Sprint, the ªGoing Forwardº logo, and other trademarks are trademarks of 
Sprint Nextel. 

AirCard!  and ªHeart of the Wireless Machineº!  are registered trademarks of Sierra 
Wireless.

Sierra Wireless, the Sierra Wireless logo, and the red wave design are trademarks 
of Sierra Wireless.

Windows !  is a registered trademark of Microsoft Corporation.

QUALCOMM!  is a registered trademark of QUALCOMM Incorporated.

InstallShield!  is a registered trademark and service mark of InstallShield 
Corporation.

All other trademarks are property of their respective owners.

Copyright

@ 2006 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. Sprint, the ªGoing Forwardº logo, and other 
trademarks are trademarks of Sprint Nextel.

@2006 Sierra Wireless. All rights reserved.

Document 2130685 Revision 1.0
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Limitation of Liability

The information in this manual is subject to change without notice and does not 
represent a commitment on the part of Sierra Wireless. SIERRA WIRELESS AND ITS 
AFFILIATES SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, 
SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR REVENUE OR 
ANTICIPATED PROFITS OR REVENUE ARISING OUT OF THE USE OR INABILITY TO USE 
ANY SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR ITS AFFILIATES 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR THEY ARE 
FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its 
affiliates aggregate liability arising under or in connection with the Sierra Wireless 
product, regardless of the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the Sierra Wireless 
product.

Additional Information and Updates

For up-to-date product descriptions, documentation, application notes, firmware 
upgrades, troubleshooting tips, and press releases, visit:

www.sierrawireless.com
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Sect ion 5A

Safety and Notices

In This Section

l Important Notice

l Safety and Hazards

l Care and Maintenance

This section describes important guidelines regarding your Sprint Mobile 
Broadband Card.
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Important Notice

Because of the nature of wireless communications, transmission and reception of 
data can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or 
be totally lost. Although significant delays or losses of data are rare when wireless 
devices such as the Sprint Mobile Broadband Card by Sierra Wireless (AirCard 595) 
CDMA modem are used in a normal manner with a well-constructed network, 
they should not be used in situations where failure to transmit or receive data 
could result in damage of any kind to the user or any other party, including but not 
limited to personal injury, death, or loss of property. SPRINT SPECTRUM L.P. accepts 
no responsibility for damages of any kind resulting from delays or errors in data 
transmitted or received using the Sprint Mobile Broadband Card by Sierra Wireless 
(AirCard 595) CDMA modem, or for failure of the Sprint Mobile Broadband Card by 
Sierra Wireless (AirCard 595) to transmit or receive such data.

Safety and Hazards

Do not operate the Sprint Mobile Broadband Card by Sierra Wireless (AirCard 595) 
in areas where blasting is in progress, where explosive atmospheres may be 
present, near medical equipment, life support equipment, or any equipment 
which may be susceptible to any form of radio interference. In such areas, the 
Sprint Mobile Broadband Card by Sierra Wireless (AirCard 595) MUST BE POWERED 
OFF. It can transmit signals that could interfere with this equipment.

Do not operate the Sprint Mobile Broadband Card by Sierra Wireless (AirCard 595) 
in any aircraft, whether the aircraft is on the ground or in flight. In aircraft, the 
Sprint Mobile Broadband Card by Sierra Wireless (AirCard 595) MUST BE POWERED 
OFF. When operating, it can transmit signals that could interfere with various 
onboard systems.

The driver or operator of any vehicle should not operate the Sprint Mobile 
Broadband Card by Sierra Wireless (AirCard 595) while in control of a vehicle. 
Doing so will detract from the driver or operator©s control and operation of that 
vehicle. In some jurisdictions, operating such communications devices while in 
control of a vehicle is an offense.

Care and Maintenance

See page 11.
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Sect ion 5B

Terms and Conditions

In This Section

l Terms and Conditions of Services

This section contains the terms and conditions of service for your Sprint Mobile 
Broadband Card.
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Terms and Conditions of Services

Effective September 1, 2005 

Thanks for choosing Sprint. These terms and conditions are part of your 
agreement with Sprint for PCS (CDMA) Services. Separate terms apply for any 
iDEN products or services.

Please note these terms may not be the most current version. You can get a 
current version of the terms on our website at www.sprint.com  or by requesting a 
copy from us at 1-888-211-4PCS. 

A para solicitar esta literatura en espaJol, por favor contactar a 1-888-211-
4PCS(4727).

General. This agreement (ªAgreementº) covers the terms on which we agree to 
provide and you agree to accept any service or product we make available to you, 
including your wireless services, wireless devices, etc. (collectively ªServicesº). You 
accept this Agreement when you do any of the following: (a) provide your written 
or electronic signature; (b) accept through an oral or electronic statement; (c) 
attempt to or in any way use any of the Services; (d) pay for any Services; or (e) 
open any materials or package that says you are accepting when you open it. The 
Agreement includes the terms in this document together with the terms 
associated with the Services you select (as described in our marketing materials, 
e.g., service plan brochures, or on our website). You represent that you are at least 
18 years old. In this document, we use the words ªwe,º ªus,º ªourº or ªSprintº to 
refer to Sprint Spectrum L.P. and its affiliates doing business as Sprint PCS.

Agreement. We may change the Agreement at any time with notice. Any changes 
to the Agreement are effective when we publish them. If you use our Services or 
make any payment to us on or after the effective date of the changes, you accept 
the changes. If we change a material term of the Agreement and that change has 
a material adverse effect on you, you may terminate the Agreement without an 
Early Termination Fee by calling 1-888-567-5528 within 30 days after the changes 
go into effect. You understand and agree that taxes, Universal Service fees and 
other charges imposed by the government or based on government calculations 
may increase or decrease on a monthly basis, and that this paragraph does not 
apply to any increases in such taxes, Universal Service fees or other charges.

Activating Service. Before activation, we may check your credit and verify your 
identity. You must have and maintain satisfactory credit to receive and continue to 
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receive Services. We may charge a nonrefundable activation fee, deposit, 
prepayment or other fee to establish or maintain Services.

Term Commitments. Unless we specifically tell you otherwise, our service plans 
require that you maintain service for a minimum term (ªTerm Service Planº), 
usually 

1 or 2 years. After satisfying this minimum term, your service plan will continue on 
a month-to-month basis unless you have agreed to extend the term for additional 
period(s). Certain service, promotional or product offers may require that you 
agree to or extend a Term Service Plan. As discussed below, we may charge you an 
Early Termination Fee if you deactivate a Term Service Plan before the end of the 
term. 

Using Services. You agree to not use our Services in an unlawful, fraudulent or 
abusive manner. You may not resell or lease Services to anyone. Sprint is not 
responsible for any opinions, advice, statements, services applications or other 
information provided by third parties and accessible through our various Services, 
including the internet. Neither Sprint, its vendors or licensors guarantees the 
accuracy, completeness or usefulness of information that is obtained through 
these Services. You are responsible for evaluating such content. 

You are also responsible for any use of our Services through any wireless device on 
your account including, but not limited to, use by children or minors. We strongly 
recommend that you closely monitor any such usage. 

Changing Services. Changes to Services will generally be effective at the start of 
your next full invoicing cycle. In certain instances, the changes may take place 
sooner, in which case your invoice will reflect pro-rated charges. Certain changes 
may be conditioned upon payment of an Early Termination Fee or certain other 
charges. 

 Termination of Services. Consistent with this Agreement: (a) we may terminate 
Services at any time with notice to you and, in certain instances, without notice; 
and (b) you may terminate Services at any time with prior notice to us. Except as 
otherwise provided in this Agreement, IF YOU TERMINATE YOUR TERM SERVICE 
PLAN EARLY, OR WE DO SO FOR GOOD CAUSE, YOU WILL BE REQUIRED TO PAY THE 
APPLICABLE EARLY TERMINATION FEE ASSOCIATED WITH YOUR SERVICES. We will 
not charge an Early Termination Fee for deactivations consistent with our Return 
Policy or for service plans being provided on a month-to-month basis. If any 
Services are terminated before the end of your current invoicing cycle, we will not 
prorate charges to the date of termination, and you will not receive a credit or 
refund for any unused Services. 
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Wireless Devices, Numbers & Email Addresses. We did not manufacture your 
wireless device and we are not responsible for any defects or for the acts or 
omissions of the manufacturer. The only warranties on your device are any limited 
warranties extended by the manufacturer directly to you or passed on to you 
through us. Your device may not accept Services directly from any other carrier. 
You do not have any rights to any number, email address or other identifier we 
may assign to your device or account; you may not modify, change or transfer any 
of these except as we allow or as allowed for by law. In certain instances, you may 
transfer your number from another carrier to us, or from us to another carrier. We 
do not guarantee that transfers to or from us will be successful. If you transfer 
your number away from us, the terms of this Agreement (e.g., Early Termination 
Fee, etc.) still apply. If a transfer to Sprint is not successful, you will be responsible 
for any discounts provided to you with the purchase of your device. See our 
printed in-store materials or visit www.sprint.com  for additional important 
information on number transfers.

Coverage. Available coverage areas for Services are generally identified in our 
mapping brochures and at www.sprint.com . This may include coverage on our 
digital network (the ªNationwide Sprint PCS Networkº) as well as coverage we 
make available to you through agreements with other carriers (ªoff networkº or 
ªroamingº coverage). 

All coverage maps are high level representations of outdoor coverage and there 
are gaps in coverage within areas shown as covered on the maps. Coverage is not 
available everywhere, nor can we guarantee you will receive coverage at all times, 
or without interruptions or delays (e.g., dropped calls, blocked calls, etc.) in the 
coverage areas we identify. Actual coverage and quality of Services may be 
affected by conditions within or beyond our control, including network problems, 
software, signal strength, your equipment, structures (including buildings in 
which you may be located), atmospheric, geographic, or topographic conditions. 

Roaming Coverage. You are roaming anytime your phone indicates that you are 
roaming. Roaming coverage is only available with certain devices and, unless 
included as part of your Services, will result in additional charges. Roaming calls 
placed ªmanuallyº (through an operator or with a credit card) will always incur 
separate and additional charges. Depending on your phone settings, you may 
automatically roam if there is a gap or interruption in coverage within the 
Nationwide Sprint PCS Network coverage area and roaming coverage areas. See 
your phone guide for how to adjust phone settings. Certain features and services 
may not be available in roaming coverage areas (including PCS Vision, voicemail, 
call waiting, call forwarding, etc.).
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Charges. Carefully review the terms of your Services. You will be assessed charges 
based on the terms of your Services including, without limitation, monthly 
recurring charges and charges based on actual usage (e.g., charges for long 
distance, roaming, call forwarding, directory assistance, etc.). Airtime and other 
time based usage charges are calculated from when your device first initiates 
contact with a network until the network connection is broken, whether or not 
you were actually successful in connecting to the intended destination. However, 
you will not be charged for voice calls that ring and do not pick up, or if you get a 
busy signal. For voice calls received by your device, you are charged from the time 
shortly before the phone starts ringing until the call is terminated. You are 
charged for an entire voice call based on the time period in which the call is 
initiated. Partial minutes of use are rounded up to the next minute. 

Sprint PCS Vision Charges. Vision usage is measured in bytes, not in minutes. Bytes 
are rounded up to kilobytes. Usage rounding occurs at the top of each clock hour 
while in a session and at the end of each session and is then charged to you based 
on the terms of your Services. Depending on your Services, usage may be charged 
against an allowance or on a fixed price per kilobyte. Usage charges may be 
rounded up to the next cent at monthly or other intervals. In certain instances, you 
may not know that your session has not ended. As long as your device is 
connected to our network, you will incur data usage charges. You will be charged 
for all data directed to the internet address (or ªIP addressº) assigned to your 
device, regardless of who initiates the activity or whether your device actually 
receives the data. This includes, but is not limited to, the amount of data 
associated with the particular information/item (e. g., game, ringer, email, etc.), 
additional data used in accessing, transporting and routing this information/item 
on our network, data from partial or interrupted downloads, re-sent data, and 
data associated with unsuccessful attempts to reach websites or use applications. 
Based on these and a number of other factors (e.g., the specific application, 
network performance, etc.) data used and charged to you will vary widely, even for 
the same activity. Estimates of data usage - for example, the size of downloadable 
files - will not be accurate or a reliable predictor of actual usage. Your invoice will 
not separately identify the number of kilobytes att ributable to your use of specific 
sites, sessions or services. 

Taxes and Surcharges. We invoice you for taxes, fees and other charges levied by or 
remitted directly to federal, state, local or foreign governments including, without 
limitation, sales, gross receipts, Universal Service, use, and excise taxes. If you claim 
any tax exemption, you must provide us with a valid tax-exempt document. Tax 
exemptions are not applied retroactively. We also invoice you for surcharges that 
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we collect and keep to pay for the costs of complying with government programs 
such as number pooling and portability, and Enhanced 911 service; these charges 
are not the taxes nor government imposed assessments. 

Invoicing & Payment. Invoicing cycles and dates may change from time to time. 
Monthly recurring and related charges for Services are generally invoiced one 
invoicing cycle in advance. Other charges are invoiced soon after they are incurred. 
Most usage is generally applied to the invoicing cycle in which they are incurred, 
but in some instances may be applied to subsequent invoicing cycles. You are 
responsible for all charges associated with any device activated on your account, 
regardless of who used the device. You must pay all charges by the due date on 
the invoice. Past due amounts accrue late charges until paid at the rate of 5* per 
month or at the highest rate allowed by law and may result in immediate 
suspension of your account. If you agree to any auto-payment option through 
banking or credit account, we may initiate payment from the account for all 
amounts we invoice you without additional authoriza tion or notice. Based on your 
credit or payment history, we may require certain forms of guaranteed payment 
as a condition of maintaining Services. If we invoice you for amounts on behalf of 
a third-party, payments received are first applied to amounts due to us. You may 
be charged additional fees for certain methods of payment and for payments 
denied by a financial institution. Acceptance of payments (even if marked ªpaid in 
fullº) does not waive our right to collect all amounts that you owe us. 

Disputed Charges. Disputes concerning any charges invoiced must be raised within 
60 days of the date of the invoice. You accept all charges not disputed in this time 
period. Disputes can only be made by calling or writing us as directed on your 
invoice.

Account Spending Limit & Deposits. We may impose an account spending limit 
(ªASLº) on any account without notice. We will notify you of an ASL based on your 
credit or payment history and may reduce the ASL at any time with prior notice. 
An ASL should not be relied on to manage usage on your account. We may 
suspend an account without prior notice when the account balance reaches the 
ASL, even if the account is not past due. Services can be restored upon payment of 
an amount that brings the account balance below the ASL and any past due 
amounts. If we require a deposit for you to establish or maintain an account, we 
will hold the deposit as partial guarantee of payment for Services. We may change 
the deposit amount at any time with notice for good reason. Except as we allow, a 
deposit may not be used to pay any invoice or delay payment. The deposit 
amount, the length of time we hold the deposit and changes to the deposit 
amount are determined based on your credit and payment history. The rate of 
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interest, if any, on the deposit is subject to change. We may mix deposits with our 
other funds. If your account is terminated for any reason, we may without notice 
apply your deposit to any outstanding charges. We may send any remaining 
deposit amounts to your last known address within 75 days after account 
termination. If the funds are returned to us, you may claim these funds for one 
year from the date of return. Any money held during this one-year period will not 
accrue interest for your benefit and are subject to a servicing fee charged against 
the balance. You forfeit any portion of the money left after the one-year period.

Other Sprint PCS Vision Terms. You will not receive voice calls while using Vision. 
Vision is not available for use with server devices or host computer applications, 
other systems that drive continuous heavy traffic or data sessions, or as 
substitutes for private lines or frame relay connections. Unlimited Vision plans/
options may not be used with Sprint PCS phones or smart phones being used as a 
modem in connection with other equipment (e.g., computers, etc.) through use of 
connection kits or other phone-to-computer/PDA accessories, or Bluetooth or 
other wireless technology. We may terminate services without notice for any 
misuse. You may have access to certain games, ringers, screen savers and other 
items on our Vision site (ªPremium Servicesº) that are available for an additional 
charge. You will be billed for Premium Service purchases on your Sprint PCS invoice 
based on the charges as specified at purchase. Subject to the terms of the content 
purchased, we may delete premium and non-premium items downloaded to any 
storage areas we may provide, including any pictures, games and other content. 
We may limit the amount of Premium Services you may purchase in a specific 
timeframe (month, week, day, or other time period).

Voice Command. Calls to 911 or similar emergency numbers cannot be placed 
through the Voice Command feature. See our printed in-store materials or visit 
www.sprint.com  for additional important information on this optio n.

Wireless Web. Wireless Web Services may be available depending on your device 
and Service plan/option. This is not a Vision service. Usage is calculated on 
minutes used and generally deducts from your Service plan minutes. See our 
printed in-store materials or visit www.sprint.com  for additional important 
information on this option.

Lost or Stolen Equipment. If your device is lost or stolen, please notify us 
immediately by calling 1-888-211-4PCS. You are responsible for all charges 
incurred before you notify us of the loss or theft. You agree to cooperate 
reasonably with us in investigating suspected unlawful or fraudulent use.
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Messaging. You may incur charges in accessing, sending or receiving messages on 
your device. We may impose limits on the number of voicemail, text, email or 
other messages that can be retained through your account. Indicators of 
messages on your device, including mailbox icons, may not always provide an up 
to date indication of new messages and you may at times need to manually reset 
or clear your mailbox indicator. Legitimate messages may be interrupted by 
software aimed at prevention of SPAM or similar messages.

Caller ID. If you do not want people you call to receive the number assigned to your 
phone, call us at 1-888-211-4PCS for information about automatic Caller ID 
blocking. The number assigned to your phone can be blocked on a per-call basis by 
dialing \67 + Destination Number + TALK (or similar key). Caller ID blocking is not 
available when using Vision or Wireless Web services. 

TTY Access. A TTY (also known as TDD or Text Telephone) is a telecommunications 
device that allows people who are deaf or hard of hearing, or who have speech or 
language disabilities, to communicate by telephone. TTY doesn©t work with all 
devices. If you have a TTY-capable device, it may not function effectively, or at all, 
when attempting 911 calls and should not be relied on for such calls.

Disclaimer of Warranties. WE MAKE NO REPRESENTATIONS OF WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING (TO THE EXTENT ALLOWED BY LAW) ANY 
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE CONCERNING YOUR SERVICES OR WIRELESS DEVICE. WE DO NOT 
PROMISE UNINTERRUPTED OR ERROR-FREE SERVICES AND YOU AGREE TO HOLD 
US HARMLESS FOR ALL SUCH PROBLEMS. 

Limitation of Liability.  Neither we nor our vendors, suppliers or licensors are liable 
for any damages arising out of or in connection with any: (a) act or omission by 
your, or another person or company; (b) providing or failing to provide Services, 
including deficiencies or problems with your wireless device, our network 
coverage or Services (e.g., dropped, blocked, interrupted calls/messages, etc.); (c) 
traffic or other accidents, or any health-related claims allegedly arising from the 
use of Services, any wireless devices or related accessories; (d) content or 
information accessed while using our Services, such as through the internet; (e) 
interruption or failure in accessing or attempting to access emergency services 
from your phone, including through 911, E911 or otherwise; or (f) events due to 
factors beyond our control, including acts of God (including, without limitation, 
weather-related phenomena, fire or earthquake), war, riot, strike, or orders of 
governmental authority. In the event we are found to be responsible to you for 
monetary damages relating to the Services (including wireless devices), you agree 
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that any such damages will not exceed the pro-rated monthly recurring charge for 
your Services during the affected period.

NO CONSEQUENTIAL OR OTHER DAMAGES. UNDER NO CIRCUMSTANCES ARE WE 
LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR SPECIAL DAMAGES 
OF ANY NATURE WHATSOEVER ARISING OUT OF OR IN CONNECTION WITH 
PROVIDING OR FAILING TO PROVIDE SERVICES, PHONES OR OTHER EQUIPMENT 
USED IN CONNECTION WITH THE SERVICES, INCLUDING, WITHOUT LIMITATION, 
LOST PROFITS, LOSS OF BUSINESS, OR COST OF REPLACEMENT PRODUCTS AND 
SERVICES. THIS SECTION SURVIVES TERMINATION OF THIS AGREEMENT.

MANDATORY ARBITRATION OF DISPUTES. INSTEAD OF SUING IN COURT, YOU AND 
SPRINT AGREE TO ARBITRATE ANY AND ALL CLAIMS, CONTROVERSIES OR DISPUTES 
AGAINST EACH OTHER ARISING OUT OF OR RELATING TO THIS AGREEMEN, 
INCLUDING, WITHOUT LIMITATION, THE SERVICES, ANY PHONES/EQUIPMENT, OR 
ADVERTISING, EVEN IF IT ARISES AFTER YOUR SERVICES HAVE TERMINATED, AND 
INCLUDING CLAIMS YOU MAY BRING AGAINST SPRINT©S EMPLOYEES, AGENTS, 
AFFILIATES OR OTHER REPRESENTATIVES, OR THAT SPRINT MAY BRING AGAINST 
YOU (ªCLAIMSº). THE FEDERAL ARBITRATION ACT APPLIES TO THIS AGREEMENT 
AND ITS PROVISIONS, NOT STATE LAW, GOVERN ALL QUESTIONS OF WHETHER A 
CLAIM IS SUB^ECT TO ARBITRATION. THIS PROVISION DOES NOT PREVENT EITHER 
YOU OR SPRINT FROM BRINGING APPROPRIATE CLAIMS IN SMALL CLAIMS COURT, 
BEFORE THE FEDERAL COMMUNICATIONS COMMISSION OR A STATE PUBLIC 
UTILITIES COMMISSION. 

YOU AND SPRINT FURTHER AGREE THAT NEITHER SPRINT NOR YOU WILL ^OIN ANY 
CLAIM WITH THE CLAIM OF ANY OTHER PERSON OR ENTITY IN A LAWSUIT, 
ARBITRATION OR OTHER PROCEEDING; THAT NO CLAIM EITHER SPRINT OR YOU 
HAS AGAINST THE OTHER SHALL BE RESOLVED ON A CLASS-WIDE BASIS; AND THAT 
NEITHER SPRINT NOR YOU WILL ASSERT A CLAIM IN A REPRESENTATIVE CAPACITY 
ON BEHALF OF ANYONE ELSE. IF FOR ANY REASON THIS ARBITRATION PROVISION 
DOES NOT APPLY TO A CLAIM, WE AGREE TO WAIVE TRIAL BY ^URY.

A single arbitrator engaged in the practice of law will conduct the arbitration. The 
arbitration will be filed with and the arbitrator will be selected according to the 
rules of either ^AMS or the National Arbitration Forum (ªNAFº), or, alternatively, as 
we may mutually agree. We agree to act in good faith in selecting an arbitrator. 
The arbitration will be conducted by and under the then-applicable rules of ^AMS 
or NAF, wherever the arbitration is filed or, if the arbitrator is chosen by mutual 
agreement of the parties, the then-applicable rules of ÂMS will apply unless the 
parties agree otherwise. All expedited procedures prescribed by the applicable 
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rules will apply. We agree to pay our respective arbitration costs, except as 
otherwise required by rules of ^AMS or NAF, as applicable, but the arbitrator can 
apportion these costs as appropriate. The arbitrator©s decision and award is final 
and binding, and judgment on the award may be entered in any court with 
jurisdiction. 

If any party files a judicial or administrative action asserting a claim that is subject 
to arbitration and another party successfully stays such action or compels 
arbitration, the party filing that action must pay the other party©s costs and 
expenses incurred in seeking such stay or compelling arbitration, including 
attorneys© fees.

If any portion of this Mandatory Arbitration of Disputes section is determined to 
be invalid or unenforceable, the remainder of the Section remains in full force and 
effect. 

Miscellaneous. You may notify us by calling us at 1-888-211-4PCS, or use that 
number to get our current address for written notice. We may send you notice to 
your last known address in our invoicing records, or by calling leaving you a voice 
message on your wireless device or home phone. Properly addressed written 
notice is effective three days after deposit in the U.S. mail, postage prepaid. This 
Agreement is governed by and must be construed under federal law and the laws 
of the State of Kansas, without regard to choice of law principles. If either of us 
waives or fails to enforce any requirement under this Agreement in any one 
instance, that does not waive our right to later enforce that requirement. If any 
part of this Agreement is held invalid or unenforceable, the rest of this Agreement 
remains in full force and effect. Section headings are for descriptive, non-
interpretive purposes only. You may not assign this Agreement to any other 
person or entity without our prior written approval . This Agreement (including 
any referenced documents and attachments) makes up the entire agreement 
between us and replaces all prior written or spoken agreements. 

@ 2006 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. Sprint, the ªGoing Forwardº logo and other 
trademarks are trademarks of Sprint Nextel. iDEN is a trademark of Motorola, Inc.
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Glossary

1X
One Times Radio Transmission Technology (the ªone timesº refers to the 
frequency spectrum). Also known as Sprint PCS Vision. Supports Internet 
connections with data rates up to 153 kbps. Actual speed depends on the network 
conditions. Compare to 1xEV-DO.

1xEV-DO
A high-speed standard for cellular packet data communications. Also known as 
Sprint Power Vision.

1xEV-DO Rev. A supports Internet connections with data rates up to 3.1 Mbps 
(downlink from the network) and 1.8 Mbps (uplink to the network). Average data 
rates are roughly 600-1300 kbps (downlink from the network) and 300-400 kbps 
(uplink to the network).

1xEV-DO Rev. 0 supports Internet connections with data rates up to 2.4 Mbps 
(downlink from the network) and 153 kbps (uplink to the network). Average data 
rates are roughly 400-700 kbps (downlink from the network) and 40-80 kbps 
(uplink to the network)

Actual speed depends on the network conditions. Compare to 1X.

bps
bits per secondÐThe actual data speed over the transmission medium.

broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

CDMA
Code Division Multiple AccessÐA wideband spread spectrum technique used in 
digital cellular, personal communications services, and other wireless networks. 
Wide channels (1.25 MHz) are obtained through spread spectrum transmissions, 
thus allowing many active users to share the same channel. Each user is assigned 
a unique digital code, which differentiates the individual conversations on the 
same channel.

dBm
decibels relative to 1 milliwatt
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dormant
The network switches the data connection into dormant mode if there is no traffic 
on the connection for some time. When you resume data traffic, the high-speed 
data connection becomes active.

ESN
Electronic Serial NumberÐThe unique serial number assigned to the modem for 
cellular network use. Either the ESN or MEID is on the label on the card, and is also 
displayed in the Device Info & Diagnostics window (page 70). See also MEID.

FCC
Federal Communications CommissionÐThe U.S. federal agency that is responsible 
for interstate and foreign communications. The FCC regulates commercial and 
private radio spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast licensing. Consult 
www.fcc.gov.

IS
Interim StandardÐAfter receiving industry consensus, the TIA forwards the 
standard to ANSI for approval.

kbps
kilobits per secondÐActually 1000, not 1024, as used in computer memory size 
measurements of kilobytes.

LAN
Local Area Network

LED
Light Emitting DiodeÐA semiconductor diode that emits visible or infrared light.

Mbps
Megabits per second.

MEID
Mobile Equipment Identifier ÐThe unique second-generation serial number 
assigned to the Sprint Mobile Broadband Card for cellular network use. Either the 
MEID or ESN is on the label on the card, and is also displayed in the Device Info & 
Diagnostics window (page 70). Compare to ESN.
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MHz
megahertzÐOne million cycles per second

PC Card
Add-in memory and communications cards for portable computers. PC Card is a 
trademark of the PCMCIA.

PCMCIA
Personal Computer Memory Card International AssociationÐThe organization that 
standardizes PC Cards.

PCS
Personal Communications ServicesÐA cellular communication infrastructure.

roaming
A cellular subscriber is in an area where service is obtained from a cellular service 
provider other than Sprint.

Sprint Mobile Broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

SprintPCSConnection Manager
Software that allows you to manage the Sprint Mobile Broadband Card's actions 
and monitor your connections.

Sprint PCS Vision
Sprint's advanced multimedia third generation services available on the network. 
See 1X.

Sprint Power Vision
Sprint's advanced multimedia third generation services available on the network. 
See 1xEV-DO.

system tray
Usually located in the bottom right of the screen (near the clock). When 

Sprint PCS Connection Manager is running, it places an icon  in this area, which 
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you can use to monitor the connection state (page 39). If you right-click the icon, a 
shortcut menu is displayed (page 56):

TIA
Telecommunications Industry AssociationÐA standards-setting trade organization, 
whose members provide communications and information technology products, 
systems, distribution services, and professional services in the United States and 
around the world. Consult www.tiaonline.org .

ToolTip
Text that displays when you position the mouse pointer over an area of the screen 
(for example, over an indicator).

VPN
Virtual Private Network

WAN
Wide Area Network
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Index
Numerics
1-888-211-4PCS  28
1X Only (Network Mode)  62
1X, 1xEV-DO

description  5
amount of data transferred  46
application to automatically launch upon 
network connection  45

automatically connect when ready  62
cannot connect  82
connect  43
coverage - determine  39
dormant indicator  34
end connection  46
icons  34
roaming indicator  34
transmit/receive indicator  34
warning when roaming  44

1xEV-DO Only (Network Mode)  62
3G

see 1X, 1xEV-DO

A
About Sprint PCS Connection Manager  73
accessibility  90
account, access  28
account, setting up  24
Activating and Using PCS Service  24
activating the card  24
activation  24
activation code  26
Activation Wizard

overview  24
Activation Wizard button  63

aircraft  40, 104
Alert Log  69
alerts  69
always on

description  5
billing  76
set  33

Always on top  60
Always show Welcome screens  62
Always-on connection  5
amount of data transferred  46
antenna, guidelines for use  95
AOL  76
approvals  89

assistance  28, 47
authentication  90
auto-launch Sprint PCS Connection 
Manager  32

Auto-launch upon network connection  45
Automatic (Network Mode)  62
Automatic (roaming option)  62
automatically connect to network  62
automatically start Sprint PCS Connection 
Manager  32

AutoPreview  77

B
bandwidth optimization

enable  64
indicator  34

Bandwidth Optimization On  64
basics  31
behavior when the card is locked  48
billing, and always on  76
blasting  104
bookmarks  50
business usage  68

C
caching  64
call duration  68
Cannot connect to the nationwide 
SprintPCS network  82

care and maintenance  11
CDMA

networks  4
roaming - description  4
signal strength indicator  34
specification  90

change the lock code  50
channel spacing  89
Check for updates once per month  60
Check Now button  60
Clear Log  69
Close Sprint PCS Connection Manager  42
compression

enable  64
indicator  34

conditions of service  105
connect  43
connect automatically  62
Connected  37
connected icon  39
Connecting  36



122 Index

connecting icon  39
connection

1X or 1xEV-DO (Network Mode)  62
alert log  69
Always-on  5
amount of data transferred  46
application to automatically launch upon 
network connection  45

automatically connect when ready  62
cannot connect  82
diagnostics  70
end  46
establish  43
history  68
issues  69
launching  43
make  43
Network Mode  62
states  35, 39
warning when roaming  44

Connection History  68
Connection Manager

see Sprint PCS Connection Manager
connection states  39
contents of package  6
Could not prepare data services  82
coverage maps  28
coverage type - determine  39
Create Report  72
current  89
customer support  28

D
data compression

enable  64
indicator  34

data optimization
See data compression

data profile  26
data provisioning  26
data speeds  76
data transferred, amount of  46
default connection  43
delete Sprint PCS Connection Manager  51
Device Info & Diagnostics  70
Device Locked  37
Device powered off  38, 40
diagnostics  70
dial-up account  76
dimensions  91

disconnect  46
Disconnected  36
disconnected icon  39
disk space required  9
Displaying system information  72
document number  98
dormant icon  39
driver installation  20
drop test  91

E
E911 & position location  90
edit

Sprint PCS Connection Manager settings  
58

Sprint PCS Power Vision/Vision 
connection  61

eject the card  21
electrical specifications  89
electronic serial number  26
encryption - required for IOTA  9
end a connection  46
environmental specifications  91
error messages - viewing  69
ESN  26
EV-DO. See 1X, 1xEV-DO.
exit Sprint PCS Connection Manager  42
expand Sprint PCS Connection Manager  41
expanded view of Sprint PCS Connection 
Manager  41

F
FAQ  75
favorites  50
fax  90
FCC

compliance  94
ID  94

firmware upgrades  99
forgot the lock code  48
frequencies, transmit and receive  89
frequency stability  89
Frequently Asked Questions  75

G
General options in Settings window  59
Getting Help  27
Getting Started  7
glossary  117
GO automatically when ready  62
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GO button  43
GO button is unavailable  81

H
hard drive space required  9
hazards  104
headset jack  91
Help

overview  28
alert log  69
contact number  28
device info and diagnostics  70
diagnostics  70
frequently asked questions  75
menu options  53
online Help  47
Sprint Customer Service  28
Sprint.com  28
tests  70
troubleshooting  79

hibernation mode  77
high encryption  9
history  68
hospital  40
humidity  91

I
icons

Sprint PCS Connection Manager  34
system tray  39

Image Compression  65
image compression

configure  64
indicator  34

IMSI_S  26
indicators

Sprint PCS Connection Manager  34
system tray  39

information, system  70
initial lock code  48
Initializing  36
inserting the card  20
installation

overview  7
Installed files  72

interference  40
Internet Over The Air  26
introduction  ii
invoice, request copy of  28
IOTA (Internet Over The Air)

description  26

IOTA Provisioning window  26
Unable to prepare data services  82

K
Keep Connection History  60
knowledge base  28

L
Launch Connection Manager automatically  
60

LED  88
liability, limitation of  99
life support equipment  104
light  88
Limitation of Liability  99
links, access  50
lock card

immediately  48
upon startup  49

lock code
overview  47
change  50
initial lock code  48
warning  48

locked card
behavior when the card is locked  48
change the lock code  50
initial lock code  48
unlock the card  49

log, alert  69
log, connection  68

M
maintenance  11
make a connection

1X or 1xEV-DO (Network Mode)  62
always on  62
amount of data transferred  46
application to automatically launch upon 
network connection  45

automatically  62
cannot connect  82
connect to Sprint Power Vision/PCS Vision  
43

Network Mode  62
maps, coverage  28
MDN  26
medical equipment  104
MEID  26
memory required  9
Menu
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all options  53
About Sprint PCS Connection Manager  73
Alert Log  69
Connection History  68
Device Info & Diagnostics  70
Exit  46
Links  50
Menu button  35
Settings  58
Software Updates  72
system tray menu  56

Menu button  35
menu options

Sprint PCS Connection Manager menu  53
system tray menu  56

messages - viewing  69
Microsoft VPN (PPTP) Connection  45
minimize Sprint PCS Connection Manager

immediately  42
on startup  60

minus sign in Sprint PCS Connection 
Manager  41

Mobile IP  90
MSID (Mobile System ID)  25, 26

N
NAM  90
nationwide Sprint Power Vision/PCS Vision 
network
1X or 1xEV-DO connection (Network 
Mode)  62

always on connection  62
amount of data transferred  46
application to automatically launch upon 
network connection  45

automatically connect when ready  62
availability status  70
cannot connect  82
CDMA wireless network, description  4
connect  43
coverage - determine  39
frequently asked questions  75
optimization settings  64
performance, improve  64
roaming indicator  34
roaming options  62
signal strength indicator  34

network
 See nationwide Sprint Power Vision/PCS 
Vision network

Network Mode  62

No device  36
non-expanded view of Sprint PCS 
Connection Manager  41

non-preactivated card  24
non-preferred roaming area  34
notices  103
notices, regulatory  94

O
on top, always  60
online Help  47
operating temperature  91
optimization

enable  64
indicator  34

optimize performance  77
optimize settings  64
OTAPA  90
OTASP  90

P
package contents  6
patents  97
PCS Connection Manager

see Sprint PCS Connection Manager
PCS Vision

see Sprint PCS Vision
performance, improve  64, 77
personal usage  68
phone number

during Activation Wizard  26
Sprint Mobile Broadband Card  47

planes  104
Play sound effects  60
plus sign in Sprint PCS Connection Manager  
41

port configuration  70
position location  90
power button  91
Power Off Modem  40
Power On Modem  40
Power Vision, Sprint (1xEV-DO). See 1X, 
1xEV-DO.

powered off  38, 40
PPTP - Microsoft VPN (PPTP) Connection  45
preactivated card  24
preferred roaming list  90
Preview Pane  77
PRL  90
problems  79
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products, Sprint PCS  50
profile - data  26
properties of connection, change  61
Protocol Compression  65
provisioning  24, 26

Q
questions

See troubleshooting

R
radio frequency specifications  89
radio modem, power off  40
receive frequencies  89
records of connection history  68
regulatory information  93
regulatory notices  94
Relock modem when program exits  49
remove Sprint PCS Connection Manager  51
remove the card  21
report of system information  72
restore Sprint PCS Connection Manager  42
RF specifications  89
Roam Guard  44
Roam Mode  62
Roam Only (roaming option)  62
roaming

description  4
display warning message  44
indicator  34
PRL  90
settings  62

RSSI  34, 70
Running Diagnostics  70

S
Safety and Hazards  104
Safety and Notices  103
SAR  95
Searching for service  36, 81
security

overview of user lock  47
warning  48
behavior when the card is locked  48
change the lock code  50
high encryption - required for IOTA  9
IOTA - high encryption requirement  9
lock card immediately  48
lock card upon startup  49
unlock card  49

service plan, add options  28

service, conditions of  105
service, searching for  81
services, Sprint PCS  50
Setting Up Service  23
Settings window

overview  58
General  59
Optimization  64
Sprint PCS Vision  61

shortcut menu  56
show Welcome screens  62
signal strength

diagnostic tests  70
indicator  34

SMS  90
software

components  10
lock card immediately  48
lock card upon startup  49
menu options  53
minimize  42
minimize on startup  60
remove  51
restore minimized  42
specifications  90
uninstall  51
unlock card  49
update  72
upgrading Windows  83
user lock  47
version information  73
Windows, upgrading  83

Software Updates  72
sound effects, play  60
specifications

environmental  91
mechanical  91
radio frequency and electrical  89
software  90

speeds, data transmission  76
Sprint (roaming option)  62
Sprint Customer Service  28
Sprint Mobile Broadband Card

inserting  20
phone number  47

Sprint PCS Connection Manager
overview  32
1X or 1xEV-DO connection (Network 
Mode)  62

About Sprint PCS Connection Manager  73
amount of data transferred  46



126 Index

application to automatically launch upon 
network connection  45

automatically connect when ready  62
cannot connect  82
close  42
configure  58
expand Sprint PCS Connection Manager  
41

FAQ  75
frequently asked questions  75
icons  34
icons in system tray  39
links  50
menu options  53
minimize  42
minimize on startup  60
Network Mode  62
remove  51
restore  42
security features  47
settings  58
start  32
start automatically  32
stopped working after Windows upgrade  
83

system tray menu  56
uninstall  51
updates  72
upgrading Windows  83
version information  73
window overview  33
Windows upgrade  83

Sprint PCS Connection Manager settings
1X or 1xEV-DO connection (Network 
Mode)  62

change  58
compression  64
General  59
Optimization  64

Sprint PCS Connection Manager stopped 
working after I've upgraded to a different 
version of Windows  83

Sprint PCS products and services  50
Sprint PCS Services

Sprint Customer Service  28
Sprint PCS Vision

1X or 1xEV-DO connection (Network 
Mode)  62

Always show Welcome screens  62
amount of data transferred  46
application to automatically launch upon 
network connection  45

automatically connect when ready  62
cannot connect  82
connect  43
coverage - determine  39
disconnect  46
end connection  46
Network Mode  62
settings  61
warning when roaming  44
See also 1X, 1xEV-DO.

Sprint Power Vision (1xEV-DO).  See 1X, 
1xEV-DO.

Sprint roaming  62
Sprint web site  28
Sprint, contacting  28
sprint.com  28
standby current  89
start a connection

application to automatically launch upon 
network connection  45

automatically connect when ready  62
immediately  43
specify 1X or 1xEV-DO connection 
(Network Mode)  62

warning when roaming  44
Start in system tray  60
start Sprint PCS Connection Manager

automatically  32
manually  32

states of connection  35
status information  70
status of connection  35
Stop button  46
stop the card  21
storage temperature  91
support  28
suspend mode  88
system information  70, 72
System parameters  72
system tray

connection states  39
icons  39
menu  56
shortcut menu  56
start in  60

T
taskbar icon

shortcut menu  42
TCP/IP optimization

enable  64
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indicator  34
technical specifications  87
technical support  28
telephone number of card  47
temperature

operating  91
storage  91

Terms and Conditions  105
terms and definitions (glossary)  117
tests, diagnostic  70
trademarks  98
transferred data, amount of  46
transmission speeds  76
transmit frequencies  89
transmit/receive icon  34
transmitter power  89
troubleshooting

common causes of problems  80
alert log  69
cannot connect  82
contact information  28
Could not prepare data services  82
FAQ  75
GO button is unavailable  81
run diagnostic tests  70
searching for service  81
stopped working after Windows upgrade  
83

Troubleshooting wizard  28
Unable to prepare data services  82
wizard  28

Troubleshooting wizard  28
TTY  90
type of coverage - determine  39

U
uninstall Sprint PCS Connection Manager  
51

unlock the card
initial lock code  48
instructions  49

Update Data Profile  26
update the software  72
updates, check for latest  99
Updating User Profile¼  26
upgrading Windows  83
URL to automatically launch upon network 
connection  45

URLs - favorites  50
USB port  70

user lock
overview  48
warning  48
change the lock code  50
lock card immediately  48
lock card upon startup  49
unlock the card  49

User Lock Change button  63

V
vehicle, operating  104
version information  73
vibration  91
Viewing your phone number  47
views of Sprint PCS Connection Manager  41
Vision

see Sprint PCS Vision, and 1X, 1xEV-DO
Voice  90
voltage  89
VPN  77
VPN program to automatically launch upon 
network connection  45

W
warning

lock code, regarding  48
roaming, display message  44

warranty  6, 112
weak signal  81
Web site

automatically launch upon network 
connection  45

favorites  50
Sprint.com  28

Welcome screen, always show  62
white paper  77
Windows

auto-launch Sprint PCS Connection 
Manager  60

upgrading  83
wizard

Activation Wizard  24
Troubleshooting  28

www.sprint.com  28


